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Thank You !!' for purchasing your new System Controller hardware and software application from
PESA. We appreciate your confidence in our products. PESA produces quality, state-of-the-art equipment
designed to deliver our users the highest degree of performance, dependability and versatility available
anywhere. We want you to know that if you ever have a concern or problem with a PESA product, we
have a team of engineers, technicians and customer service professionals available 24/7/365 to help
resolve the issue.

Our commitment is to continue earning the trust and confidence of our customers throughout the industry
by incorporating cutting-edge technology into the highest quality, most cost effective products on the
market. And we would like to invite you to tell us how we’re doing. If you have any comments or
suggestions concerning your PESA equipment, please contact our Customer Service Department.

Again thank you for choosing PESA, and we look forward to a long-term partnership with you and your
facility.

SERVICE AND ORDERING ASSISTANCE SERVICE DEPARTMENT
PESA Tel: 256.726.9222 (24/7)
103 Quiality Circle, Suite 210 Toll Free: 800.323.7372
Huntsville AL 35806 USA Fax: 256.726.9268
www.PESA.com Email: service@PESA.com
MAIN OFFICE

Tel: 256.726.9200
Fax: 256.726.9271

© 2011 PESA Switching Systems, Inc. All Rights Reserved.
© 2003 PESA Switching Systems, Inc. All Rights Reserved

3500Pro is a trademark of PESA Switching Systems, Inc. in the United States and/or other countries.

No part of this publication (including text, illustrations, tables, and charts) may be reproduced, stored in
any retrieval system, or transmitted in any form or by any means, including but not limited to electronic,
mechanical, photocopying, recording or otherwise, without the prior written permission of PESA.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

All information, illustrations, and specifications contained in this publication are based on the latest
product information available at the time of publication approval. The right is reserved to make changes at
any time without notice.
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ABOUT THIS MANUAL

DOCUMENTATION AND SAFETY OVERVIEW

This manual provides detailed instructions foritisallation, operation, and maintenance of the
PESA equipment.

It is the responsibility of all personnel involvadthe installation, operation, and maintenance of
the equipment to know all the applicable safetylagons for the areas they will be working in.
Under no circumstances should any person perform any procedure or sequence in this manual

if the procedural sequence will directly conflict with local Safe Practices. Local Safe Practices
shall remain as the sole determining factor for performing any procedure or sequence outlined

in this document.

WARNINGS, CAUTIONS, AND NOTES

Throughout this manual you should notice variousriags, Cautions, and Notes. These
addendum statements supply invaluable informatememing to the text that they address. It is
imperative that audiences read and understand tiengents to avoid possible loss of life,
personal injury, destruction/damage to the equigmeand/or added information that could
enhance the operating characteristics of the eqnprfi.e., Notes). The following subsections
represent a description of the Warnings, Cautiand,Notes statements contained in this manual:

WARNING

Warning statements identify conditions or practiceshat can result in loss of
life or permanent personal injury if the instructions contained in the
statement are not complied with.

CAUTION

Caution statements identify conditions or practicesthat can result in
personal injury and/or damage to equipment if the mstructions contained in
the statement are not complied with.

Notes are for information purposes only. Howeverthey may contain
invaluable information important to the correct installation, operation,

and/or maintenance of the equipment.
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End User Commercial License Agreement

Grant

Subject to purchase of a PESA System Controlle§A°Bwitching Systems, Inc. (PESA) grants to youoa-n
exclusive license to use the Software and accompgmpcumentation (“Documentation”) in the mannesatibed
below under “Scope of Grant.”

Limited Warranty

PESA warrants that for a period of ninety (90) d&ysn the date of acquisition, the Software, if @ged as
directed, will substantially achieve the functiagtaldescribed in the Documentation. PESA does natrant,
however, that your use of the Software will be terrupted or that the operation of the Softwaré el error-free
or secure. In addition, the security mechanismdempnted by PESA software have inherent limitati@ms you
must determine that the Software sufficiently megtsir requirements. PESA also warrants that theiane
containing the Software, if provided by PESA, isefifrom defects in material and workmanship antdseilremain
for ninety (90) days from the date you acquired Soware. PESA’s sole liability for any breachtis warranty
shall be, in PESA’s sole discretion: (i) to replagsur defective media; or (ii) to advise you howachieve
substantially the same functionality with the Seaftev as described in the Documentation through eeptoe
different from that set forth in the Documentatian; (jii) if the above remedies are impracticalie refund the
purchase price you paid for the System ControRepaired, corrected, or replaced Software and Deatation
shall be covered by this limited warranty for theripd remaining under the warranty that coveredadtiginal
Software, or if longer, for thirty (30) days aftkwe date (a) of shipment to you of the repaireteptaced Software,
or (b) PESA advised you how to operate the Softwsweas to achieve the functionality described ia th
Documentation. Only if you inform PESA of your plem with the Software during the applicable warygreriod
and provide evidence of the date you purchasedeade to the Software will PESA be obligated todndhis
warranty. PESA will use reasonable commercial &fdo repair, replace, advise or, for individuahsomers,
refund pursuant to the foregoing warranty withinda@s of being so notified.

THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY PESA. PESA MAKES NO
OTHER EXPRESS WARRANTY AND NO WARRANTY OF NONINFRIGEMENT OF THIRD PARTIES’
RIGHTS. THE DURATION OF IMPLIED WARRANTIES, INCLUDNG WITHOUT LIMITATION,
WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR AARTICULAR PURPOSE, IS LIMITED
TO THE ABOVE LIMITED WARRANTY PERIOD; SOME JURISDITIONS DO NOT ALLOW
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY NOT APPLY
TO YOU. NO PESA DEALER, AGENT, OR EMPLOYEE IS AUTHOZED TO MAKE ANY
MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARANTY. If any modifications are made to
the Software by you during the warranty periodh# media is subjected to accident, abuse, or ipgprose; or if
you violate the terms of this Agreement, then tasranty shall immediately be terminated. This \aaty shall not
apply if the Software is used on or in conjunctwith hardware or software other than the unmodifietsion of
hardware and software with which the software wesighed to be used as described in the DocumemtalibllS
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MY HAVE OTHER LEGAL RIGHTS
THAT VARY BY JURISDICTION.

Scope of Grant

You may:
» use the Software on any single computer;
» use the Software on a second computer so longlg®ne copy is used at a time;
» copy the Software for archival purposes, providery copy must contain all of the original Software
proprietary notices.
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You may not:
» permit other individuals to use the Software gxaender the terms listed above;
» permit concurrent use of the Software;
« modify, translate, reverse engineer, decompilgssemble (except to the extent applicable lawsifally
prohibit such restriction), or create derivativerksbased on the Software;
» copy the Software other than as specified above;
* rent, lease, grant a security interest in, oentiise transfer rights to the Software; or
* remove any proprietary notices or labels onSogware.

Title

Title, ownership rights, and intellectual properights in the Software shall remain in PESA and®rsuppliers.
The Software is protected by the copyright laws teaties. Title and related rights in the contetessed through
the Software is the property of the applicable enohbwner and may be protected by applicable lavis Ticense
gives you no rights to such content.

Termination

The license will terminate automatically if youlfeo comply with the limitations described herei®n termination,
you must destroy all copies of the Software andubeentation.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT,
CONTRACT, OR OTHERWISE, SHALL PESA OR ITS SUPPLIERSR RESELLERS BE LIABLE TO YOU
OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INDENTAL, OR CONSEQUENTIAL
DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUINTION, OR ANY AND ALL OTHER
COMMERCIAL DAMAGES OR LOSSES. IN NO EVENT WILL PESBE LIABLE FOR ANY DAMAGES IN
EXCESS OF THE AMOUNT PESA RECEIVED FROM YOU FOR AJENSE TO THE SOFTWARE, EVEN IF
PESA SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OBSUCH DAMAGES, OR FOR ANY
CLAIM BY ANY OTHER PARTY. THIS LIMITATION OF LIABIL ITY SHALL NOT APPLY TO LIABILITY
FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICAE LAW PROHIBITS SUCH
LIMITATION. FURTHERMORE, SOME JURISDICTIONS DO NOTALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND
EXCLUSION MAY NOT APPLY TO YOU.

Miscellaneous

If the copy of the Software you received was accamgd by a printed or other form of “hard-copy” Ebder
License Agreement whose terms vary from this Agesgmnthen the hard-copy End User License Agreement
governs your use of the Software. This Agreemeptasents the complete agreement concerning tieisse and
may be amended only by a writing executed by baitigs. THE ACCEPTANCE OF ANY PURCHASE ORDER
PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL ON YOURASSENT TO THE TERMS SET
FORTH HEREIN, AND NOT THOSE IN YOUR PURCHASE ORDERany provision of this Agreement is held
to be unenforceable, such provision shall be reéofronly to the extent necessary to make it enftteeaThis
Agreement shall be governed by Alabama law (extmptonflict of law provisions).
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FCC Statement

This device complies with part 15 of the FCC Ruf@peration is subject
to the following two conditions:

(1) This device may not cause harmful interfereace]

(2) this device must accept any interference reckivincluding
interference that may cause undesired operation.

Proprietary Information of PESA SWITCHING SYSTEMS, INC. \
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Section |: Getting Started

Welcome to the 3500Pro manual! This section dessrthe system and explains how to set up both the

hardware and software. For more detailed inforomasibout the hardware and software, refer to Sectio
Il and Section III.

The following topics are included in this section:

Chapter 1 — Introduction (Includes product desmipand specifications)
Chapter 2 - Installing and Setting Up the System
o Chapter 3 - Installing 3500ProLE Software
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Chapter 1 — Introduction

11

PRODUCT DESCRIPTION

PESA’'s 3500Pro System Controller is a low cost]-fletured, microprocessor-based unit
designed to interface with various configuratioisP&SA video and audio routing switchers.
The 3500Pro System Controller, working in conjunictiwith the 3500Pro Control System
software, enables users to configure and operedatang switcher system from a standard IBM-
compatible personal computer. Both the 3500Praefy<Controller and the 3500Pro Control
System software are inherently flexible and easdynfigured. The 3500ProLE has a smaller
feature set, which is designed for customers withlker systems.

The 3500Pro System Controller utilizes the Motor6B332 embedded microprocessor. In
addition, it is equipped with 4 MB of RAM, 2 MB &LASH memory, and 8 serial UARTS
making the 3500Pro System Controller a high-powecedrol platform for its size.

The 3500Pro System Controller is capable of colmigplup to a 1024 input by 1024 output,
sixteen level routing switcher system. Standaatuiees include independent control of each
level, audio-follow-video switching, virtual matrixnapping, and software reentry. Matrix
segmentation (breakup) is also a standard feaMia¢rix segmentation enables RGB, Y/C, or
multiple levels of audio to be configured as smmaftetrixes within a larger matrix. Multiple
levels of lock priority, 128 salvo capability, futliagnostics, and all-call switching are also
included in the 3500Pro Controller's standard fiestyolus the ability to configure 1200 sources
and destinations.

The controller supports the low-cost RCP contralgis manufactured by PESA. The control
panels are connected via twisted pair cable andearemotely located up to 4000 feet from the
controller. The control panels communicate wite 800Pro Controller over a standard RS-485
interface. Two RS422 ports and two RS232 portspaogided for communications interface
with the routing switcher system, the control sgstmputer, and additional equipment items.

The 3500Pro System Controller is available as iadstédone unit (rack mountable) or as a plug-in
unit for routing switchers. The 3500Pro Controlferfully compatible with PESA's System 5,
Lynx, Cougar, Jaguar, Tiger, and Cheetah linesidicaand video routing switchers.
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1.2  MODELS OF THE 3500PRO CONTROLLER
The six models of the 3500Pro System Controllerdaseribed in the following table.

Table 1:  3500Pro System Controller Basic Models

Model Description

3500Pro Internal controller. One or two may bealtst in any large;
scale router (except the TDM3000).

3500Pro-S Single: One controller in a 1RU chassis.

3500Pro-D Dual: Two controllers in a 2RU chassis.

3500Pro-SE Single Expandable: One controller ilestain a 2RU chassis.
Expand with Model 3500Pro-DE.

3500Pro-LE Internal controller. One or two may betalled in any larger

scale router (except the TDM3000).
3500Pro-LE-S Single: One controller in a 1RU chassi
3500Pro-LE-D Dual: Two controllers in a 2RU chassis

3500Pro-LE-SE | Single Expandable: One controlletaited in a 2RU chassis.
Expand with Model 3500Pro-LE-DE.
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1.3 SPECIFICATIONS

1.3.1  Operational Environment
TEeMPEIAtUIe .....eveviieeceeiieeeee e eeennn . 2A0CC
Operational HUMIdity ..o 0-90% Non-Condensing

1.3.2  Physical Characteristics

3500Pro-S
Height ..o 1.75in (45 mm) (1 Rack Unit)
WIAEN L. 19 in (483 mm)
DEPLN ..o 8 in (203 mm)
3500Pro-D
Height ..o 3.50 in (89 mm) (2 Rack Units)
WIAEN .. 19 in (483 mm)
DEPLN ..o 10 in (254 mm)
1.3.3 Power
3500Pro-S
INPUL e 8.81465 VDC
Input Connector, 3500-S.........cccoovveiiiereeeene. 3-Contact Proprietary
3500Pro-D
INPUL e 8.81465 VDC
Input Connector, 3500-D.........ccccoovvevvimmmmeennnnnn. 6-Contact Proprietary

PS130 Internal Power Supply (Optional for 3500Pr@1ily)

Part NUMDEY .......ovviiiiiiiiiiiiiiiiiiie b e 81-9065-2048-0
INPUE e 105-240 VAC, 50-60 Hz

Input Connector IEC 320 Receptacle
OULPUL e, -.&F9VDCat55A

1.34 SRU Power Pack

Part NUmbDer........coooo e 81-9065-2215-0
AC to DC Power. PacK.........cccccceviiieeiimmnnne. Input AC 95 to 240 VAC
............................................ OutC +12 VDC and -12 VDC
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1.35 |EC 320 Line Cords

us
Part NUMDBEI ..., 81-9028-0403-0
(OF0] o] gT=To1 (0] £, IEC 320-C13 to NEMA 5-15P
UK
Part NUMDBEI ..., 81-9028-TBD-0
(OF0] ] gT=To1 (0] £ IEC 320-C13to BS 1363A
Euro
Part NUMDBEI ..., 81-9028-0411-0
0F0] o] g1=To1 (0] £ IEC 320-C13 to CEE 7/7 Schuko

1.3.6 Communications

NUMDEE Of RS-232 P OIS . e ettt eaaens 2.
NUMDEE Of RS-422 P OIS ... .iniieiiee et eaaennd X,
Data RaAte.....c v e 9600/38400 thau

* = One port is dedicated to use as PRC interfdices an RS422, but customer can't utilize
it for 3%-party installs.

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 5



Q» PE SA 3500PROLE — SECTION |

81-9059-0549-0 Rev. E

Chapter 2 — Installing and Setting up
the System

2.1

2.2

2.3

To get started with the 3500Pro system, first yeadto install and set up the hardware. Next,
you need to connect the hardware to the compugrwiil run the 3500Pro software. Finally,
you will install the 3500Pro software and establgmmunication with the hardware. This
chapter describes how to perform these steps. tidddlly, this chapter provides basic
instructions for setting up your system. For dethinformation about the hardware and how to
operate it, refer to Section Il. For detailed nmfation about the software and how to work with
it, refer to Section Il

SHIPPING DAMAGE INSPECTION

Immediately upon receipt, all shipping containen®wdd be inspected for damage caused in
transit. If any damage is noted, save all packiagenml and contact both PESA and the carrier as
soon as possible.

UNPACKING

"b"\ This equipment contains static sensitive devicesA grounded wrist strap
CAUTION and mat should be used when handling the 3500Pro &gm Controller.

Carefully unpack the equipment and compare thespadeived against the packing list. If any
parts appear to be missing, please contact PES &diately.

INSTALLATION LOCATION

This controller was designed for installation istandard 19-inch equipment rack located in an
environment conforming to the specifications shaw@hapter 1. Each unit should be located as
close as possible to its associated equipment namze cable runs. Sufficient space must be
provided behind the equipment racks to allow fontoal, signal, and power cables. All panel
mounting holes should be utilized and mounting heaure tightened securely.

Consideration should be given to the connectiothsf equipment to the supply circuit and the
effect that possible overloading could have on aweent protection circuits and supply wiring.
Refer to the nameplate ratings when addressingtimsern.
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Install the equipment into the rack as follows:

1. Insert the panel assembly into the equipmeck end support the bottom of the panel
assembly until all mounting hardware has been liesstand properly tightened.

Install the bottom two panel-mounting screws.
Install the top two panel-mounting screws.
Install any remaining panel-mounting screws.

a M w DN

Tighten all panel-mounting screws until theg secure.

2.4 INTERNAL INSTALLATION - MODEL 3500PRO

One or two 3500Pro or 3500ProLE System Controttarsbe installed in a any of the large scale
routers except for the TDM3000. For detailed unstions for installing the controller, refer to
the related product manual.

2.5 INTERFACE CONNECTIONS

For reasons of personal safety, and to prevent gart@the equipment or cables, the following
guidelines should be followed when connecting cabbethis equipment.

1. Install the equipment in the rack before connectialgles.
2. All cables should be carefully strain relieved teyent connector separation.

3. To the extent possible, separate control, sigmal,power cables to minimize crosstalk and
interference.

4. The liberal use of nylon cable ties to secure caldethe rack is encouraged. This will
minimize the amount of force transmitted to theipment and help route cables away
from hazardous areas.

5. Route cables away from walk areas to avoid creatisgfety hazard.
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251 Model 3500-S Connection Guide

The following section shows how to connect the ¥500and 3500Pro-S. For detailed
information about each available option, refer éatn .

Vertical Sync Signal
Input (optional or
terminate with 75 ohms)

RS-485 serial
| RS-422 CPU Link CPU Alarm communication to RCPs Power Connectors

POWER

Cl9OO0OL_TLTd B B GN,: W o] O
v :j °

RM 2 3 4
GND
]_ 5600 POLLING PORTS. COM3/PRC Ccom2 COML SYSTEM V CONTROL AUXILIARY STROBE

ol HEEE P9 [kl ) Je T_—J9

Vi

[¢]

&)
Communications Connect to computer |
interface to PRC type running 3500Pro software )
routing switcher with RS-232 NULL System 5 control interface
modem cable (DB37-Male connector)

May be connected to
PC with RS-232 NULL
modem cable

Figure 1: 3500Pro-S Connection Guide

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 8



Q» PE SA 3500PROLE — SECTION |

81-9059-0549-0 Rev. E

252  Models 3500Pro-D (and 3500Pro-SE/3500Pro-DE) Connection Guide

The following section shows how to connect the 3%500D, SE, and DE. For detailed
information about each available option, refer éatn .

Secondary RS-232

CPU Link
pC pé)(;/\r/]?]relcnttoerrface Connect to the PC running 3500Pro with
a RS-232 DB9-Male connector (null-
Power Supply Optional Vertical modem cable)
Alarm Connector Sync Signal Input
3-contact CPU Alarm
| Connector
|
Q EXTEII?NAL o Q
AR fﬂ Ol DuAL SYSTEM CONTROLLER
DOD SYNC COM 2 C 1
® 0 FCTrRCIIE:.
orc COM3/PRC  COM4 SYSTEM V CONTROL IT?LUNS -1
o o | G G [ C_—— 9 o
RS-422 Loop-Through RS.422  System 5 control
Connector. Connect to other CPU interface (DB37-
PESA PRC type equipment Male connector)
RS-422 serial RS-485 serial
communication interfaces communication
using DB9-Male connectors to RCPs

Figure 2: 3500Pro-D (and 3500Pro-SE / 3500Pro-DE)

253 Model 3500Pro Connection Guide

Installing internal 3500Pro models are different &ach switcher. For detailed information
about how to install 3500Pro internal models and/ ho connect the hardware, refer to the
appropriate switcher manual.

However, you willalways need to establish a connection from the COM1 poerial 1 port
on the rear of the router switcher to the PC thltrun the 3500Pro software.
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2.6 INSTALLING THE SOFTWARE

After installing the hardware and establishing areztion with the computer where you will
install the software, you need to install the 35@0Boftware. Then you can create a basic
configuration to communicate with the controllehi§ chapter describes how to do this.

Before you start this procedure, make sure you kamaected the 3500Pro System Controller to
the PC where you will install the software (seeuFég 3 and 4).

S E[e]ele)e]ammmrams === S
Sle [Boliorminiy I_[CTD_][_CT[_D_]O S o _o| |[O (ﬁc,]@ -
Connect to computer
running 3500Pro
software with RS-232
NULL modem cable
Figure 3: Connecting the 3500Pro-S to the PC
Connect to the PC
running 3500Pro with a
RS-232 DB9 NULL
Modem connector
O EXTERNAL — ° Q
ALZ}Q’J‘ O DUAL SYSTEM CONTROLLER
DOU SYNC COM 2 C 1
® 0 TRt
orc cows/prRc___ coma SYSTEMV CONTROL ?LLS
o o JEEp L | a—) S

Figure 4: Connecting the 3500Pro-D, DE, and SE tde PC

Systems using an internal 3500Pro are different degmding on the type of
system you purchased. However, you will always neetb establish a

connection from the COM1 port or the Serial 1 Portto the PC.
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2.6.1 Hardware and Software Requirements
The minimum PC requirements to run Win3500Pro are:

Processor: 500 MHz or above
Memory: 128 MB of RAM or more
Monitor: 800X600 SVGA or better

Serial Port: One serial port available from COMtotlgh COM4 available for CPU
Link use (Minimum of al6550 UART preferred.)

Hard Disk: 100 MB of available space

Operating System: Micros6ft Windows NT™ 4.0, Microsoft  Windows
2000/Professional, or Microsoft Windows XP (Homel &mvo)

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 11
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2.6.2

General Specifications Table

Table 2: Specifications Table
Specification 3500Pro 3500ProLE

Max. Number of Levels 16 8
Max Number of 1024 144
Inputs/Outputs per Level
Max Number of 32 16
Components
Max Number of Tielines 64 0
Max Number of 254 254
Categories
Max Number of Sources 1200 180
Max Number of 1200 180
Destinations
Max Number of Reentries 8 0
Max Number of Salvos 128 (1024 switches 64

can be allocated

across all 128

salvos)
Component Types RM5 (System 5) PRC, XTN, TGR
Offset Range 0-255 0-4094
Strobe Range 1-5 1-63

Specification

3500Pro and 3500ProLE

Lock Priority Range

0-255 ("0" is Highest Priority)

Max Number of Control 500
Panels

Panel Address Range 1-1023
Panel Requestor Code 1-65535

Range

Chop Rate

1-255 Frames

Proprietary Information of PESA SWITCHING SYSTEMS, INC.
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Chapter 3 Installing 3500Pro/
LE Software

3.1 READ THIS FIRST!

o Installing the 3500Pro/3500ProLE software is not a&imple procedure.
You must follow the instructions in this guide EXACTLY. Please read
this document before you install the software.

e PESA highly recommends that you use either MicrosoWindows 2000
or Microsoft Windows XP Professional.

o Installation of the 3500Pro/3500ProLE must be perfoned by a user
with  Administrator privileges. Please refer to yow System
Administrator for more information about acquiring these privileges.

e The 3500Pro software suite requires the installatio of Microsoft
Transaction Server (MTS), Microsoft Data Access Coponents
(MDAC) V2.8, and the Microsoft Desktop Engine (MSDE000)
database. These components must be properly inded before the
3500Pro/3500ProLE will operate properly. This doament details how
these component are installed.

This document describes the installation process ifdoth the 3500Pro and
3500ProLE tool suite. Though many of the figuresni the document
describe the 3500ProLE installation, they apply tahe 3500Pro as well.

3.2 HARDWARE AND SOFTWARE REQUIREMENTS
The minimum PC requirements to run 3500Pro/3500Brate:

PESA highly recommends that you use either MicrosbiwWindows 2000 or
Microsoft Windows XP Professional.

e Processor: 500 MHz
e Memory: 128 MB of RAM
e Monitor: 800X600 SVGA

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 13




Q» PE SA 3500PROLE — SECTION |

81-9059-0549-0 Rev. E

e Serial Port: One serial port (Minimum of a 1635ART preferred.)

e Hard Disk: 300 MB of available space on your Grelri

e Operating System: Microsoft® Windows® 2000, MiastisVindows XP (Home and Pro),
or Microsoft Windows NT™ 4.0.

3.3 IMPORTANT INFORMATION FOR WINDOWS NT USERS!

Although the 3500Pro/3500ProLE runs on Windows NGO, 4 is strongly suggested that you
migrate your operating system to Windows 2000 ondtsivs XP (Professional). Upgrading your
software allows you to take advantage of newer d4ioft technologies that are marginally
supported under Windows NT 4.0.

If you are going to install the 3500Pro/3500Proluisler Windows NT 4.0, yomust install the
Microsoft Transaction Server (MTS). The MTS inkstabn package is included in the Windows
NT Option Pack available from Microsoft:

http://www.microsoft.com/ntserver/nts/downloads/reommended/NT4OptPk/default.asp

The web page provides instructions for installitg tservice pack. Follow the instructions
exactly!

Microsoft Transaction Server (MTS) must be installel on your machine in
order for the 3500Pro/3500ProLE to operate. The wtallation software

provides no indication of whether the MTS softwards installed or not. What
appears to be a valid installation will not work if the MTS is not already
installed.

Installing the MTS will require you to reboot your machine.

3.4 3500PRO/3500PROLE SOFTWARE INSTALLATION SEQUENCE

Installation of the 3500Pro/3500ProLE must be perfoned by a user with
Administrator privileges. Please refer to your Sygeem Administrator for more

information about acquiring these privileges.
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Follow these steps to install the software.

1. Insert the 3500Pro/3500ProLE CD into the CD drivEhe installation program should
automatically start when the PC recognizes thealiaston program.

If the program does not automatically start, yon dauble-click the executable installation
program on CD drive. (3500ProVx.xInstall. EXE oi08®roLEVx.xInstall. EXE depending
upon the type of control software you are instglhn

The first dialog encountered during the installation process is a README file
about converting the *.db extension files. If thigs a first-time installation, the
user may just ignore this message and continue.

I x|

Convert *.db Files

If this iz a first time installation, press the "Caontinue’" button below.

If upgrading from a previous version of the 3500Pmo applications, pleaze read the text below. If this does not
apply to you, press the "Contifiug” button below ta complete the installation. IF you need to convert ang *.db
filez or uninstall the previous version, then press "Exit" below to abort this installation.

The databaze structure for version 1.5 of the 3500P1a has chanaged. It iz incompatible with previous A
werzionz of the 3B00Po applications and previous verzsions of the database are incompatible with verzion
15

If you hawve any configurations saved az *.db filez, theze files will have to be converted to ASCI files so
that they may be imported into the new version of 3500PTa. Start the 3500Fra Configuration Editar, open
the = db configuration file, and corvert it ko an ASCI file uzing the "FILE - TR&MSFER
COMFIGURATIONS... - EXFORT COMFIGURATION TO ASCIH FILE" menu optionz. Complete this
process for each *.db configuration file pou desire to uze in werzion 1.5 of 3800FT0,

********** Uninztalling Previous Yerziong of the 3500P0
Previouz wersionz of 3500Po must be uninstalled before inztalling version 1.5, 1f you da not have a copy of
FR00ProDbd dmin. exe installed with the version of 3500Pro that you are currently uzing, there should be a

=l

whize Inztallation Wizard®

If this is an upgrade installation from a previousversion, the README file
explains the necessity and the process to save afinfigurations that were
previously saved as *.db files to *.txt files so @t the new *.db file that this
upgrade creates can be populated to include the oldiata that is pertinent to
the controller configuration.

The *.db files are the actual database files thataontain ALL of the database
information and will typically change from version to version. However, after
an upgrade, some data in the older version may besquired to be included in
the new upgrade. That is the reason *.txt files & created from the old *.db
files to include just the data that is required tobe imported.
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2. If you are installing the program on Windows NT add not have the Microsoft
Transaction Server (MTS) installed on your PC, yall see the following message (see
Figure 5):

MTS Installation |

kizrozoft Trangaction Server iz required for the proper operation of the 3500PR0 or 3500FR0O LE
programs. PESA recommends the uze of the Windows 2000 Professional or Windows =P
Frofezzional operating spstems az thep have built-in zuppart for the Microsoft Tranzaction Server. If
an upgrade of the operating system iz not an option, Microsoft Tranzaction Server can be obtained
for Windows HT4 by installing the MT Option Pack. The MT Option Fack can be obtained from
kizrozoft's web zite at the following address:

hittp: A v, microgzoft comd ntzerverdnts /downloads frecommended M T 40 ptPE /default. azp

Press the "Exit 3500PR0/3500PR 0 LE Installation And [nstall MTS" button below and install
Miu:r_u:usu:uft Tranzaction Server. Once Microsaft Tranzaction Server iz ingtalled, rn this application
agair.

Exit 3500PRO/3500PE0 LE Installation And lnstall MTS

Figure 5: MTS Installation Not Detected
You will need to acquire the Windows NT option pdceam Microsoft and install it before
continuing with the 3500Pro/3500ProLE installation.

3. The first items installed by the installation pragr are the Microsoft Data Access
Components (MDAC). Select OK in the following wowd (see Figure 6).

Wise Installation System x|

Thiz inztallation requires MDAC [Microzoft Data
Access Components] to be ingtalled [ar

re-inztalled] on your system. The installation of
DAL requirez a reboot before the application

inztallation can beqin.
Cancel |

Figure 6: MDAC Installation Notice

If your computer already has MDAC installed, this gep will simply be
skipped and you will not need to reboot. Insteadgo directly to MSDE
installation (Step 4).
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The following prompt (see Figure 7) displays white MDAC components are installed.

Wise Installation System

Your system iz now being prepared for the
FMDAC 2.8 installation. Thiz will anly take a
=" few moments.

Figure 7: Second MDAC Installation Notice

After MDAC is successfully installed, the followirgrompt (see Figure 8) displays. You
must reboot your computer to proceed with the Ilzgtan of 3500Pro/3500ProLE. Make
sure all other applications are closed, then sé#&cin this window.

Wise Installation System |

i j FMOALC 2.8 haz been succeszfully installed.

The system must reboat now ik arder ta finizh
the MDA installation. The application
iriztallation will start automatically after the
rebioot.

Figure 8: MDAC Successful Installation Notice
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4. After you reboot, the installation program will t& and begin installation of the
Microsoft Desktop Engine (MSDE2000). The softweak install the installation files into
temporary directories on your machine’s C drive dhen install the software. This
process will take a number of minutes to complsée (Figures 9 and 10).

Microsoft SOL Server Desktop Engine

0| Please wait while Windows configures Microzoft SGEL Server
|‘#‘-" Desktop Engine

Timne remaining: 45 seconds

ANERREREER Cancel |

Figure 9: MSDEZ2000 Install Progress Window

Microsoft Data Engine (MSDE2000) Installatior

Installation of MSDE2000 will take a few minutes, As
zooh az the installation of MSDE2000 iz completed, the
=" guztem will need ta restart.

Figure 10: MSDEZ2000 Install Notice

Upon completion of installing the MSDE2000, the Wil reboot.

If your computer already has MSDE2000 installed, tls step will simply be
skipped and your PC will not reboot.
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5. After installation of the MSDE2000, the actual 3B06/3500ProLE components are
installed. This portion of the install displaygeeting window (see Figure 11) indicating
that you have reached the portion where the a8&@0Pro/3500ProLE is installed.

*_J;-%'_e 3500PRO ¥1.5 Release August 2004 ll

Welcome to 3500PRO %1.5 Release August 2004 Setup
pragram. Thiz program will ingtall 3500PR0 %Y1 .5 Release August
2004 on your computer.

Itiz strongly recommended that pou exit all Windows programs
before running this Setup Progran.

Click Cancel to quit Setup and close any programs you have
running. Click Mest to continue with the Setup program.

WaARMNING: This program iz protected by copyright law and
intermnational treaties.

|Jnauthorized reproduction or digtribution of this program, ar any
partion of it, may result in severe civil and criminal penalties, and
will be prozecuted to the maximum estent pozzible under law.

Cancel |

Figure 11:
The software

then presents End User
3500Pro/3500ProLE (see Figure 12).

3500Pro Install Greeting Window

License Agmem@&ULA) for
The user mosgpd the license by clicking the

NEXT button for the installation to continue.

;@_« 3500PRO ¥1.5 Release August 2004 1'

3500PRO3500PRO LE CONTROL SYSTEM LICENSE AGREEMENT

B PRESSING THE "NEXT"BUTTON, vOU ARE COMSENTING TO BE BOLND BY THIS «
LICENSE AGREEMENT. IF¥OU DO NOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, CLICK THE "CANCEL" BUTTOM AND THE INSTALLATION PROCESS

WILL MOT COMTIMUE OR RETURM THE SYSTEM CONTROLLER TO THE PLACE OF
PURCHASE.

PES& 3500PR0 CONTROL SvSTEM END USER COMMERCIAL LICENSE AGREEMENT
GRAMT. Subject to purchasze of a PESA System Controller, PESA Switching Systems, Inc.
[PESA)] grants to you a non-exclusive icense to uge the Software and accompanying

documentation [*'Documentation] in the manner described below under *Scope of Grant."

LIMITED ‘WARRANTY.

PESA warrants that for a period of ninety [90] davs from the date of acquisition, the Software, LI

Wige Installation Wizard®

Mest » | Cancel |

Figure 12:  3500Pro License Agreement
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After accepting the license, the software prompty fa location where the

3500Pro/3500ProLE software is to be installed. Us=Browse button to select the

location for the 3500Pro/3500ProLE software. Yaum anstall it in any directory on your
computer, or you can create a new directory. Wthercorrect directory location displays
in the following window (see Figure 13), sel&fEXT.

43 3500PR0O ¥1.5 Release August 2004 x|

Destination Location A
(1

Setup will inztall 3B00PRO V1.5 Releaze dugust 2004 in the following folder.

To install into a different folder, click Browse, and select another folder,

Yo can choosze not to ingtall 3300PR0 1.5 Releasze dugust 2004 by clicking Cancel to exit
Setup.

" Destination Folder

C:%Pragran Filesh3500PR0 Browse... |

Wize Installation Wizard®

< Back

Cancel |

Figure 13: Install Location Window

If you select thd8rowse button, this window will display (see Figure 14jelect the drive
where you want to install the software. If you wémcreate a new directory, type in the
new directory path in the top of the window. Whka correct directory location displays,
selectOK.

Select Destination Directory

x|
0K I
% Program Files Cancel |
£ 3500Pm
£ Accessonies
£ Adaptec
£ adobe
3 Aaile Product Collabaration
£ AutolCaD 2002
£ Common Files
£3 ComPlus &pplications

£ FileSubrnit LI

IIE [ j

Figure 14:  Select Destination Directory Window
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Next, select the components you want to instatclEitem that you want to install should

have a check mark displayed (see Figure 18&onfigurator” is the Configuration Editor
where you set up configuration files.Status” is the Status module that allows you to

monitor the 3500Pro/3500ProLE system. Select fitmies you want to install and select

NEXT.

*_-Fl!- 3500PRO ¥1.5 Release August 2004

Select Components

I the options lizt
below, select the
checkboxes for the
ophiong that pau
would like to have
inztalled.

The dizk space fields
reflect the
requirements of the
optiohz you have
zelected,

Wize Ingtallation ‘Wizard®

[+ Spstern Setup 2020k

¥ Configuratar M2k

[+ Statuz & Diagrostics 2E56 k.
Dizk Space Required: a0as k
Dizk Space Remaining: 5450233 k

¢ Back

Cancel |

Figure 15:  Select Components Window

Proprietary Information of PESA SWITCHING SYSTEMS, INC.

21



3500PROLE — SECTION |
81-9059-0549-0 Rev. E

The resulting screen (see Figure 16) allows youadd the associated icons of the
previously selected components to your desktop.

1_-,@_: 3500PRO ¥1.5 Release August 2004 ﬂ

Add Desktop Shortcuts ﬂ‘)
&0

Do pou wizh to have shorbouts to the 35300PR0 Configuration and Status applications added
to the desktop?

* ‘ez

" Mo

wiize Installation Wizard®

< Back

Cancel |

Figure 16: Desktop Icon Selection

If desired, click in theres radio button. If not desired, click in tiN® radio button. Then,
click onNext, which will continue the installation sequence.

6. After the 3500Pro/3500ProLE software has beenlirgtahe 3500Pro COM+ modules are
registered with MTS and the runtime database tadnlednitialized (see Figure 17). You
do not have to do anything during this process.

Retrieving Catalog Application
Finding out if application already exists
Application already exists

Installing components
Exporting application

Figure 17: COM+ Registration Installation Progress
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After this process completes, the final window thigp (see Figure 18). Selg€inish to
complete the software installation process.

43 3500PRO ¥1.5 Release August 2004 x|

JR00PRO Y5 Release August 2004 has been succeszsfully
ingtalled.

Press the Finizh button to exit thiz installation.

< Back

Cancel |

Figure 18:  Finish the Installation

The installation of the 3500Pro/3500ProLE is nomptete.

You can invoke the 3500Pro/3500ProLE programs tjindhe START menu:
START->PROGRAMS->PESA 3500Pro Vx.x(where x.x isthe current version)
or:

START->PROGRAMS->PESA 3500ProLE Vx.x
The programs can also be invoked by using the iowtalled on the user’s desktop.
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3.5 DOWNLOADING A CONFIGURATION TO THE CONTROLLER

You can test the connection between the computrttza controller by downloading a sample
configuration file to the controller. A sampleefils available on the product CD and is called
“cougar combo numeric”.

éTIDN

This will change the settings on the controller. Dmot perform these steps if youy
do not want the current configuration to be overwriten!

If you have an existing configuration file, you caruse it to test the connectior
instead of the delivered sample file.

SR L

When you are done with all the installation stgmu can open the 3500Pro Configuration
Editor by selectingtart > Programs > 3500Pro > Configuration Editor.

Selectrile > New Configuration Database. Enter a name for the new configuration and
selectOpen.

The software will ask if you want to create titee SelectYes.
SelectFile > Transfer Configuration.
Selectmport Configuration From ASCII File, then select Execute.

Change to the CD drive with the 3500Pro instiaaCD. You will see a file called
“cougar combo numeric”. Select this file then sel@pen. Whenlmport is Complete
displays, seleddK.

Now, selectDownload Configuration to Controller and selecExecute. A prompt asks
if you want to continue. Sele@K.

This will send the information in the configuratifife you just opened to the controller.
You will see:

e Exporting the configuration to a file

e Downloading to the Controller

o Committing the configuration to Flash
o Configuration Download is complete

Congratulations! You have established a connection.

Now, you can start to customize the configuratide fo suit your requirements. Go on to
Section Il for detailed instructions for addingyour configuration and customizing it for your
applications.

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 24



Q} PE SA 3500PROLE — SECTION I

81-9059-0549-0 Rev. E

Section Il: Hardware Reference Guide

The section provides detailed information about35@0Pro System Controller hardware. The 3500Pro-
S and 3500Pro-D are both described.
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Chapter 4 — Hardware Description

This chapter provides descriptions for all of thaitable features in the 3500Pro-S and 3500Pro-
D System Controllers. For details about interra@Pro controllers, refer to the appropriate
routing switcher manual.

4.1 MoDEL 3500PRO-S

All interface connections are made at the reahisféquipment as shown in Figure 19.

PRINTER @ CPUALARM
]_ 5600 POLLING PORTS. COM3/PRC CoML SYSTEM V CONTROL AUXILIARY STROBE

olel FEET PORCIRCIY fC——9C 9

Figure 19:  3500Pro-S Rear View

STTOO00 F—TFH

411  3300/3500Pro SYNC/ 6600 POLLING PORT 1 (J1)

This BNC connector is used for an optional vert®ahc signal input. If it will not be used,
install a 75 Ohm terminator (Part No. 81-9029-08%8-This signal allows the switches to be
scheduled for vertical, interval timing.

412 6600 POLLING PORTS?2, 3, and 4 (J2, J3, J4)

These BNC connectors are reserved for future U$ere are no internal connections and they
do not need to be terminated.

413 PRINTER (J5)

This DB25-Female connector is reserved for futige uSee Figure 20 for an orientation view
showing contact locations.

131211109 8 76 5 43 2 1

O O0O0O0O0DO0O0O0OO0OO0COOOO O
000000 0COOOOO

252423222120191817161514

Contact locations when viewed
from rear of chassis.

Figure 20:  3500Pro-S J5 (PRINTER) Connector

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 26



Q» PE SA 3500PROLE — SECTION I

81-9059-0549-0 Rev. E

414 COM 1(J14), COM 2 (J13)

These DB9-Male connectors provide RS-232 serialmsomcation interfaces. See Figure 21
for an orientation view showing contact locations.

COM 1 is the primary RS-232 CPU Link and may bernsmted to the PC running
3500Pro Control System software with a null modexhle (Part No. 81-9028-0393-0).
COM 1 may only be used with the P1E protocol, #tezi 9600 or 38400 baud. The
communication rate is selected with switch S1 excrileed in “S1-3 COM 1 Rate” on
page 45.

COM 1 may also be connected to an external modeng @ AT Serial Modem cable
(Part No. 81-9028-0400-0).

COM 2 is a secondary RS-232 CPU Link, which may de connected to a PC or
external modem. COM 2 may be used with any ofpifte¢ocols shown in the following
table and may operate at either 9600 or 38400 batd.communication rate for COM 2
is determined by settings made in the 3500Pro soéiw COM2 has the same pinout as
COML1.

If necessary, a cable up to 50 feet in length mayabricated in the field. For a Null-Modem
cable, see Figure 22. For an AT Serial-Modem c¢ade Figure 23.

Table 3: PESA CPU Link Protocols

Protocol Document No.

CPU Link Protocol No. 1 (P1) 81-9062-0407+0
CPU Link Protocol No. 1 Extensions 81-9062-0408-0
(P1E)
Unsolicited Status Protocol (USP) 81-9062-0409-0
Truck Link Protocol (TRK) 81-9062-0410-0

12345

o) 9
6 789

Contact locations when viewed
from rear of chassis.

Figure 21:  3500Pro-S J13, J14 (COM 1, COM 2) Connears

DB-9 Female To: DB-9 Female To:
3500Plus-S J13 or J14 PC

J
)

CD (Carrier Detect)

RX (Receive Data)

TX (Transmit Data)

DTR (Data Terminal Ready)
SG (Signal Ground)

DSR (Data Set Ready)

RTS (Ready To Send)

CTS (Clear To Send)

RI (Ring Indicator)

CD (Carrier Detect)
TX (Transmit Data)
RX (Receive Data)

DSR (Data Set Ready)

SG (Signal Ground)

DTR (Data Terminal Ready)
CTS (Clear To Send)

RTS (Ready To Send)

RI (Ring Indicator)

© N U N WN P
©N®AUOONWR

L/ |

Figure 22:  3500Pro-S RS-232 CPU Link (Null Modem) @ble
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DB-9 Female To: DB-25 Male To:
3500Plus-S J13 or J14 External Modem

M (]
- (18| cp (Carrier Detect)
RX (Receive Data)
TX (Transmit Data)
DTR (Data Terminal Ready)

CD (Carrier Detect) | 1

RX (Receive Data) | 2

TX (Transmit Data) | 3

DTR (Data Terminal Ready) |4
SG (Signal Ground) | 5
6

7

8

9

N W

N
o

7| SG (Signal Ground)
DSR (Data Set Ready) 6 | DSR (Data Set Ready)
RTS (Ready To Send) 4| RTS (Ready To Send)
CTS (Clear To Send) 5| CTS (Clear To Send)
RI (Ring Indicator) 22| RI (Ring Indicator)

[ N

Figure 23:  3500Pro-S RS-232 CPU Link (AT Serial Moem) Cable

415 COM 3/PRC (J12), COM 4 (J6)

These DB9-Male connectors provide RS-422 serialrsomcation interfaces. See Figure 24
for an orientation view showing contact locations.

e COM 3/PRC is the communications interface to a R{g@ routing switcher system and
is connected to a routing switcher. If necessamalze up to 4000 feet in length may be
fabricated in the field as shown in Figure 25.

e COM4is an RS-422 CPU Link and may be connectedR€ with the 3500Pro software
installed. The cable may be up to 4000 feet igtlerand an RS-422 interface card must
be installed in the PC. COM 4 may be used with @ye protocols shown in Figure 26
on the next page. If necessary, a cable may be#aéd in the field as shown in Figure
26.

12345

0 G d

6789
Contact locations when viewed
from rear of chassis.

Figure 24:  3500Pro-S J6, J12 (COM 3/PRC, COM 4) Carectors

DB-9 Female To: DB-9 Female To:
3500Plus-S J12 PRC Type Device
— —
; N N ;
System Controller TX+ (High) |8 ‘ ‘ ‘ \ 8| System Controller TX+ (High)
System Controller TX- (Low) |3 3| System Controller TX- (Low)
Chassis Ground | 1 ﬂ\i 1| Chassis Ground
System Controller RX+ (High) |2 ‘ ‘ ﬁ 2| System Controller RX+ (High)
System Controller RX- (Low) |7 7 | System Controller RX- (Low)
Chassis Ground | 4 4| Chassis Ground
Chassis Ground |5 5| Chassis Ground
Chassis Ground | 6 6 | Chassis Ground
Chassis Ground | 9 9| Chassis Ground
L/ N

Figure 25:  3500Pro-S RS-422 Serial Cable
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DB-9 Female To: Customer supplied
3500Plus-S J6 Connector
— —
System Controller TX+ (High) | 2 ‘ ‘ ‘ System Controller TX+ (High)
System Controller TX- (Low) |7 N System Controller TX- (Low)
Chassis Ground | 1 %
System Controller RX+ (High) | 8 ‘ ‘ ‘ ‘ System Controller RX+ (High)
System Controller RX- (Low) | 3 N System Controller RX- (Low)
Chassis Ground | 4
Chassis Ground | 5
Chassis Ground | 6
Chassis Ground | 9
[ N

Figure 26:  3500Pro-S RS-422 CPU Link Cable

416 CPUALARM (J7)

This 3-contact connector provides the interfacetf@ CPU alarm. See Figure 27 for an
orientation view showing contact locations.

The 3500Pro operating software determines whenlamacondition is declared. During an
alarm condition, an optically isolated, closed gitexists between contacts 1 and 3. The
customer supplied external alarm circuit is coneeéclvith a cable constructed as shown in
Figure 28.

The 81-9029-0780-0 connector body has an integrainsrelief, which requires the use of a
nylon cable tie included with the connector. listlis not available, cable tie Part No.
81-9021-0028-8 may be used.

éTIDN

The alarm circuit connected to this connector mushot exceed 12VDC or
10mA.

3 2 1

N

Contact locations when viewed
from rear of chassis.

Figure 27:  3500Pro-S J7 (CPU ALARM) Connector

81-9029-0780-0 To: Customer Supplied
3500Plus-S J7 Connector
/4

Alarm High | 1 ‘ ‘ ‘ ‘
Alarm Low | 3
Chassis Ground

Figure 28:  3500Pro-S CPU Alarm Cable
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417 485 PANEL PORTS 1-4 (38, J9, J10, J11)

These 3-contact connectors are wired in parallblchvprovide RS-485 serial communication

interfaces using the PESA RCP Protocol (Document84e9062-0300-0). See Figure 29 for
an orientation view showing contact locations.

J8, J9, J10, and J11 are connected to PESA RenaoitieoCPanels with daisy-chained cables
constructed with 3-contact connectors (Part No9@29-0780-0) and shielded, twisted-pair
audio cable (Part No. 81-9028-0043-2, Belden 84B6&quivalent) as shown in Figure 30. The
connector body has an integral strain relief, whieduires the use of a nylon cable tie, which is

included with the connector. If this cable tien@t available, Part No. 81-9021-0028-8 may be
used.

3 2 1

[S~—"—"~—]

Contact locations when viewed
from rear of chassis.

Figure 29:  3500Pro-S J8, J9, J10, J11 (485 PANEL RO'S 1-4) Connectors

81-9029-0780-0 To: 81-9029-0780-0 To:

3500Plus-S J8, J9, J10 or J11 Remote Control Panel
3 2 1
High (+) |1 ) M 1| High (+)
Low (-) 3;) P 3| Low (-) - s o+
Shield (S) | 2 %(7)-2 Shield (S) ]
RCP connector
1 contact locations
‘ ‘ 3 when viewed from
—} ) rear of chassis.
Additional RCPs may be ‘ ‘ 1
daisy-chained together \f 3
as required.

Figure 30: 3500Pro-S RS-485 Serial Cable
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418 SYSTEM V CONTROL (J15)

This DB37-Male connector provides the System 5 @bmterface and uses the RM5 Protocol
(Document No. 81-9062-0155-3). See Figure 31 foroaentation view showing contact
locations.

J15 is connected to a Lynx or RM5 type routing ehat with cable assembly Part No.
81-9065-1189-2. If necessary, a cable may bedatad in the field as shown in Figure 32. If
more than one System 5 Routing Switcher will benemted to the System Controller, refer to
Drawing No. WI50-0262 for bifurcated cable constioe details.

373635343332313029282726 252423222120
O 000000000000 000O0OO0OO0 O
0000000000000 O0OO0OO0OO

191817161514131211109 8 76 5 4 3 2 1

Contact locations when viewed
from rear of chassis.

Figure 31:  3500Pro-S J15 (SYSTEM V CONTROL) Conneatr
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DB-37 Female To: DB-37 To:
3500P]us-S J15 Routing Switcher
? Input Address Bit 1 T
2 Input Address Bit 2 2
3 Input Address Bit 3 3
4 Input Address Bit 4 4
5 Input Address Bit 5 5
5 Input Address Bit 6 6
7 Input Address Bit 7 7
a Input Address Bit 8 a
9 Input Address Bit 9 9
10 Output Address Bit 1 10
1 Output Address Bit 2 1
12 Output Address Bit 3 12
13 Output Address Bit 4 13
14 Output Address Bit 5 14
15 Output Address Bit 6 15
16 Output Address Bit 7 16
17 Output Address Bit 8 17
Output Address Bit 9
18 " 18
Confidence
19 - 19
20 Readback Data Bit 1 20
Readback Data Bit 2
21 - 21
Readback Data Bit 3
22 - 22
Readback Data Bit 4
23 - 23
Readback Data Bit 5
24 - 24
Readback Data Bit 6
25 - 25
Readback Data Bit 7
26 - 26
27 Readback Data Bit 8 27
Readback Data Bit 9
28 28
Strobe 1
29 29
Strobe 2
30 30
a1 Strobe 3 a1
Strobe 4
32 32
23 Strobe 5 23
Read/Write
34 " 34
5 Primary/Secondary 5
Vertical Trigger Inhibit
36 36
Ground
37 37
L/ N

Figure 32:  3500Pro-S RM5 Control Cable
419  AUXILIARY STROBE (J16)

This DB15-Male connector is reserved for future.u&ee Figure 33 for an orientation view
showing contact locations.

123456738

00000000
o () o

9101112131415

Contact locations when viewed
from rear of chassis.

Figure 33:  3500Pro-S J16 (AUXILIARY STROBE) Connecbr
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4110 POWER (J17,J18)

These 3-contact connectors are the power connect®eg Figure 34 for an orientation view
showing contact locations.

éTIDN

To avoid damage to the 3500Pro-S System Controllethe power connectors
(J17 and J18) must never be connected to any of thalowing:

e A Lynx, Cougar or Jaguar audio routing switcher
e An external audio power supply (PS140A or PS270A)

e An RM5000 video routing switcher or its external pever supply
(PS270V)

The Model 3500Pro-S has no internal power supgly.ahd J18 are connected in parallel. One
is used for power input and the other may be used &op-through connector to provide
power to another device. Input power may be dricaum the following sources:

The 3500Pro-S may obtain power from PESA systempooents having 3-contact power

connectors by using a power cable assembly (ParBN®065-1183-7) constructed as shown
in Figure 35. If this cable is to be constructedhe field, refer to Drawing No. W150-0172 for

assembly details.

The 3500Pro-S may obtain power from PESA systempooents having 6-contact power

connectors by using a power cable assembly (ParBMN®065-1653-0) constructed as shown
in Figure 36. If this cable is to be constructedhe field, consult Drawing No. WI50-0238 for

assembly details.

e “’l“/]

Contact locations when viewed
from rear of chassis.

Figure 34:  3500Pro-S J17, J18 (POWER) Connectors

81-9029-0649-4 To: 81-9029-0649-4 To:
3500Plus-S J17 or J18 Power Source

L +V (RED) 1
5 GND (BLK) 5
-V (WHT
3 (WHT) 3

Figure 35:  3500Pro-S Power Cable with 3-Contact Pty
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81-9029-0649-4 To: 81-9029-0160-2 To:
3500Plus-S J17 or J18 Power Source
1 +V (RED) 4
2 GND (BLK) 5
-V (WHT)
3 6
1
2
3

Figure 36:  3500Pro-S Power Cable with 6-Contact Pty

4.2  MoDELS 3500PR0-D (AND 3500PRO-SE / 3500PRO-DE)

All interface connections are made at the reahisféquipment as shown in Figure 37.

EXTERNAL

] O DUAL SYSTEM CONTROLLER

(w]e]w] SYNC com2 com1
©0 FTEEn:.

POLLING
COM 3/ PRC COM SYSTEM V CONTROL
[+

PRC 4 4 3 2_1|
) o JofoC Jof o9

Figure 37:  3500Pro-D Rear View

421 EXTERNAL POWER (J5)

This 6-contact connector is the DC power interfe@enector. See Figure 38 for an orientation
view showing contact locations.

To avoid damage to the 3500Pro-D System Controllethe External Power

CAUTION connector (J5) must never be connected to any ofetollowing:
e A Lynx, Cougar or Jaguar audio routing switcher
e An external audio power supply (PS140A or PS270A)

e An RM5000 video routing switcher or its external paver supply
(PS270V)
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The Model 3500Pro-D may be configured with or withmternal power supplies. If either of
the internal power supplies are installed, J5 mayded to provide power to other equipment.
If neither of the internal power supplies is inkd] J5 is used to connect the 3500Pro-D to an
external power source. Input power may be drawmfthe following sources:

e The 3500Pro-D may obtain power from PESA system pmmants having 3-contact
power connectors by using a power cable assembrt (Ro. 81-9065-1653-0)
constructed as shown in Figure 39. If this cablstbe constructed in the field, consult
Drawing No. WI50-0238 for assembly details.

e The 3500Pro-D may obtain power from PESA system pmmants having 6-contact
power connectors by using a power cable assembrt (Ro. 81-9065-TBD-0)
constructed as shown in Figure 40. If this cablstbe constructed in the field, consult
Drawing No. WI50-TBD for assembly details.

900
olalo

Contact locations when viewed
from rear of chassis.

Figure 38:  Orientation View - 3500Pro-D J5 (EXTERNA. POWER) Connector

81-9029-0160-2 To: 81-9029-0649-4 To:
3500Plus-D J5 Power Source
1
2
3
4 +V (RED) 1
5 GND (BLK) 5
-V (WHT)
6 3

Figure 39:  3500Pro-D Power Cable with 3-Contact Ply

81-9029-0160-2 To: 81-9029-0160-2 To:
3500Plus-D J5 Power Source

+V (RED)
GND (BLK)
-V (WHT)

o g B WN B
o g B WN B

Figure 40: 3500Pro-D Power Cable with 6-Contact Ply
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422 PWRALARM (J22)

This 3-contact connector provides the interfacetierPower Supply alarms. See Figure 41 for
an orientation view showing contact locations.

Each of the two PS130 Power Supplies has its ovamnal low voltage alarm, which will be
enabled when the output voltage varies from 9VDCtb§%. During an alarm condition, an
optically isolated, closed circuit exists betweentacts 3 and 1 for Power Supply A (top), and
contacts 2 and 1 for Power Supply B (bottom). Gistomer supplied external alarm circuit is
connected with a cable constructed as shown inr€igg.

éTIDN

The alarm circuit connected to this connector mushot exceed 12VDC or
10mA.

[A]o s] 3
] o-|2
[Ho +1

Contact locations when viewed
from rear of chassis.

Figure 41:  3500Pro-D J22 (PWR ALARM) Connector

81-9029-0811-0 To: Customer Supplied
3500Plus-D J22 Connector

. PS Alarm (-)
PS Alarm B (Bottom) (+)
. PS Alarm A (Top) (+)

S
/

w N -

Figure 42:  3500Pro-D PS Alarm Cable

423  SYNC (316, J17)

These BNC connectors are wired in parallel andusesl for an optional vertical sync signal
input. The second connector is to allow the sigodde looped through the 3500Pro-D chassis
and routed to other equipment. Unused connectost be terminated with a Z5terminator
(Part No. 81-9029-0668-4).
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424 COM 1(J7),COM 2 (J8)

These DB9-Male connectors provide RS-232 serialsomcation interfaces. See Figure 43
for an orientation view showing contact locations.

COM 1 is the primary RS-232 CPU Link and may bernsmted to the PC running
3500Pro Control System software with a null modexhle (Part No. 81-9028-0393-0).
If necessary, a cable up to 50 feet in length mayabricated in the field as shown in
Figure 44. COM 1 may only be used with the P1Bqua, at either 9600 or 38400
baud. The communication rate is selected withcdw@1 as described in “S1-3 COM 1
Rate” on page 45.

COM 1 may also be connected to an external modeng @ AT Serial Modem cable
(Part No. 81-9028-0400-0). If necessary, a calgetas 50 feet in length may be
fabricated in the field as shown in Figure 45.

COM 2 is a secondary RS-232 CPU Link, which may de connected to a PC or
external modem. COM 2 may be used with any ofpifte¢ocols shown in the following

Table 4 and may operate at either 9600 or 3840@.balhe communication rate for
COM 2 is determined by settings made in the 350@®ftware. COM2 has the same
pinout as COML1.

Table 4: PESA CPU Link Protocols

Protocol Document No.
CPU Link Protocol No. 1 (P1) 81-9062-0407-0
CPU Link Protocol No. 1 Extensions (P1E 81-90628)90
Unsolicited Status Protocol (USP) 81-9062-0409-0
Truck Link Protocol (TRK) 81-9062-0410-C

12345

A=k

6789
Contact locations when viewed
from rear of chassis.

Figure 43:  3500PreD J7, J8 (COM 1, COM 2) Connectors

DB-9 Female To: DB-9 Female To:
3500Plus-D J7 or J8 PC

\

CD (Carrier Detect)
RX (Receive Data)
TX (Transmit Data)
DTR (Data Terminal Ready)
SG (Signal Ground)
DSR (Data Set Ready)
RTS (Ready To Send)
CTS (Clear To Send)
RI (Ring Indicator)

CD (Carrier Detect)

TX (Transmit Data)

RX (Receive Data)

DSR (Data Set Ready)

SG (Signal Ground)

DTR (Data Terminal Ready)
CTS (Clear To Send)

RTS (Ready To Send)

RI (Ring Indicator)

Looo\lmm-waHJ
© N ®AUOON®R

L/ -

Figure 44: 3500PreD RS-232 CPU Link (Null Modem) Cable
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DB-9 Female To: DB-25 Male To:
3500Plus-D J7 or J8 External Modem
™ -
CD (Carrier Detect) |1 8| CD (Carrier Detect)
RX (Receive Data) |2 3| RX (Receive Data)

TX (Transmit Data) | 3 2| TX(Transmit Data)
DTR (Data Terminal Ready) |4 20| DTR (Data Terminal Ready)
SG (Signal Ground) |5 7 | SG (Signal Ground)
DSR (Data Set Ready) |6 6 | DSR (Data Set Ready)
RTS (Ready To Send) |7 4| RTS (Ready To Send)
CTS (Clear To Send) |8 5| CTS (Clear To Send)
RI (Ring Indicator) |9 22| RI(Ring Indicator)

L/ N

Figure 45:  3500PreD RS-232 CPU Link (AT Serial Modem) Cable

425 COM 3/PRC (J9), COM 4 (J10)

These DB9-Male connectors provide RS-422 serialrsomcation interfaces. See Figure 46
for an orientation view showing contact locations.

e COM 3/PRC is the communications interface to a R{g@ routing switcher system and
is connected to a routing switcher. If necessargable up to 4000 feet in length may be
fabricated in the field as shown in Figure 47.cdhtains the same physical connections
as in 5-pin, PRC connector.

e COM 4is an RS-422 CPU Link. The cable may beausQ00 feet in length and an RS-
422 interface card must be installed in the PC kizet the 3500Pro software program.
COM 4 may be used with any of the protocols shawhable 4 on the previous page. If
necessary, a cable may be fabricated in the feekhawn in Figure 47.

12345

AESE

6 789
Contact locations when viewed
from rear of chassis.

Figure 46:  3500Pro-D J9, J10 (COM 3/PRC, COM 4) Carectors

DB-9 Female To: DB-9 Female To:
3500Plus-S J9 or J10 PRC Type Device
— —
; N /A ;
System Controller TX+ (High) |8 ‘ ‘ ‘ ‘ 8| System Controller TX+ (High)
System Controller TX- (Low) |3 13| System Controller TX- (Low)
Chassis Ground | 1 1| Chassis Ground
System Controller RX+ (High) |2 ‘ ‘ ﬁ 2| System Controller RX+ (High)
System Controller RX- (Low) |7 7 7| System Controller RX- (Low)
Chassis Ground | 4 4| Chassis Ground
Chassis Ground |5 5| Chassis Ground
Chassis Ground | 6 6 | Chassis Ground
Chassis Ground | 9 9| Chassis Ground
L/ L

Figure 47:  3500Pro-D RS-422 Serial Cable
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DB-9 Female To: Customer supplied
3500Plus-D J9 Connector
— —
System Controller TX+ (High) | 2 ‘ ‘ ﬁ System Controller TX+ (High)
System Controller TX- (Low) |7 System Controller TX- (Low)
Chassis Ground |1 i
System Controller RX+ (High) |8 ‘ ‘ m System Controller RX+ (High)
System Controller RX- (Low) |3 N\ System Controller RX- (Low)
Chassis Ground | 4
Chassis Ground |5
Chassis Ground | 6
Chassis Ground |9
L/ (.

Figure 48: 3500Pro-D RS-422 CPU Link Cable

42.6 CPUALARM (J18)

This 3-contact connector provides the interfacetf@ CPU alarm. See Figure 49 for an
orientation view showing contact locations.

The 3500Pro operating software determines whenlamaondition is declared. During an
alarm condition, an optically isolated, closed w@itcexists between contacts 3 and 1 for
Controller A (top), and contacts 2 and 1 for ColteroB (bottom). The customer supplied
external alarm circuit is connected with a cablestaicted as shown Figure 50.

[Alo 9| 3
] o-|2
[Ho +1

Contact locations when viewed
from rear of chassis.

Figure 49:  3500Pro-D J18 (CPU ALARM) Connector

Customer
81-9029-0811-0 To: Supplied

3500Plus-D J18 Connector
11+ Alarm (-)
2 Controller B (Bottom) Alarm (+)
sls Controller A (Top) Alarm (+)

Figure 50:  3500Pro-D CPU Alarm Cable
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427 PRC(J11)

This 5-contact connector is a loop-through conmectsed to provide an RS-422 serial
communication interface using the PESA PRC Prot@@otument No. 81-9062-0316-0). Itis
wired in parallel with J9 (COM 3/PRC). See FigGdefor an orientation view showing contact
locations.

J11 may be connected to other PESA PRC type equipwith a cable assembly (Part Number
81-9028-0395-0) constructed as shown in Figure B2his cable is to be constructed in the
field, consult Drawing No. WI50-0250 for assembatails.

5 4 3 2 1

Figure 51:  3500Pro-D J11 (PRC) Connector

81-9029-0813-0 To: 81-9029-0813-0 To:

3500Plus-D J11 PRC Type Device
System Controller TX+ (High) | 1 ﬂ ‘ ‘ 1| System Controller TX+ (High)
System Controller TX- (Low) |2 2| System Controller TX- (Low)
Chassis Ground | 3 3| Chassis Ground
System Controller RX+ (High) | 4 ‘ ‘ ‘ ‘ 4| System Controller RX+ (High)
System Controller RX- (Low) |5 15| System Controller RX- (Low)

Figure 52:  3500Pro-D RS-422 System Expansion Cable
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4.2.8

SYSTEM V CONTROL (J20)

This DB37-Male connector provides the System 5 @bmterface and uses the RM5 Protocol
(Document No. 81-9062-0155-3). See Figure 53 foroaentation view showing contact
locations.

J20 is connected to a Lynx or RM5 type routing sher with cable assembly Part No.
81-9065-1189-2. If necessary, a cable up to 8ifektngth may be fabricated in the field as
shown in Figure 54. If more than one System 5 Rgubwitcher will be connected to the
System Controller, consult Drawing No. WI50-0262r fbifurcated cable construction
information.

373635343332313029282726252423222120
O 0CO0000000000D0000D0O0O0O O
Q0000000000000 00000O0

191817161514131211109 8 7 6 5 4 3 2 1

Contact locations when viewed
from rear of chassis.

Figure 53:  3500Pro-D J20 (SYSTEM V CONTROL) Conneair
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DB-37 Female To: DB-37 To:
3500P]us-D J20 Routing Switcher
? Input Address Bit 1 T
2 Input Address Bit 2 2
3 Input Address Bit 3 3
4 Input Address Bit 4 4
5 Input Address Bit 5 5
6 Input Address Bit 6 6
7 Input Address Bit 7 7
a Input Address Bit 8 a
9 Input Address Bit 9 9
10 Output Address Bit 1 10
1 Output Address Bit 2 1
12 Output Address Bit 3 12
13 Output Address Bit 4 13
14 Output Address Bit 5 14
15 Output Address Bit 6 15
16 Output Address Bit 7 16
17 Output Address Bit 8 17
Output Address Bit 9
18 " 18
Confidence
19 - 19
Readback Data Bit 1
20 - 20
Readback Data Bit 2
21 - 21
Readback Data Bit 3
22 - 22
Readback Data Bit 4
23 - 23
o1 Readback Data Bit 5 o1
Readback Data Bit 6
25 - 25
Readback Data Bit 7
26 - 26
Readback Data Bit 8
27 - 27
Readback Data Bit 9
28 28
Strobe 1
it Strobe 2 it
30 30
Strobe 3
31 31
22 Strobe 4 22
a3 Strobe 5 a3
Read/Write
34 " 34
Primary/Secondary
35 - - Py 35
Vertical Trigger Inhibit
36 36
Ground
37 37
L/ -

Figure 54:  3500Pro-D RM5 Control Cable

429  POLLING 1-4 (312, J13, J14, J15)

These 3-contact connectors are wired in parallel provide RS-485 serial communication
interfaces that use the PESA RCP Protocol (DocuienB1-9062-0300-0). See Figure 55 for
an orientation view showing contact locations.

J12, J13, J14, and J15 are connected to PESA Ré&nateol Panels with daisy-chained cables
constructed with 3-contact connectors (Part No9@29-0780-0) and shielded, twisted-pair
audio cable (Part No. 81-9028-0043-2, Belden 84B6&quivalent) as shown in Figure 56. The
connector body has an integral strain relief, whieguires the use of a nylon cable tie that is
included with the connector. If this cable tient available, Part No. 81-9021-0028-8 may be
used.
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& PESA

When connecting RS-485 cables between the dual caniter and the actual
panels, the ordering of the pins is different. Lookclosely at the diagrams

[rlo 5| 3
] o-|2

[Hlo +1

Contact locations when viewed
from rear of chassis.

3500Pro-D J12, J13, J14, J15 (POLLING %-) Connectors

Figure 55:
81-9029-0811-0 To: 81-9029-0780-0 To:
3500Plus-D J12, J13, J14 or J15 Remote Control Panel
3 2 1
High (+) | 1 ﬂ ) 1| High (+)
Low (-) |2 3| Low (-) - S F
Shield (S) 33 %(:)— 2| shield (S) e
RCP connector
1 contact locations
‘ ‘ 3 when viewed from
%C—>_ ) rear of chassis.
Additional RCPs may be ‘ ‘ ;
daisy-chained togeth
s recired. e
Figure 56:  3500Pro-D RS-485 Serial Cable
4.3 PS130 POWER SupPPLY LINE CORDS
Always use a grounded AC receptacle to avoid a patgally lethal shock

hazard in the event of an equipment power line faal

This equipment will not meet FCC EMI limits unlessboth AC line cords are
plugged into properly grounded AC receptacles.
Each PS130 Power Supply requires a line cord (RarB81-9028-0403-0) to connect it to the AC

mains.

43
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4.4 PC BOARD SWITCH AND JUMPER SETTINGS

441  S1- Operational Mode/Config BypassyCOM 1 Rate

S1is a four-position, slide-style, dipswitch catisig of four, single-pole, single-throw (SPST)

switches numbered 1 through 4. Position 1 is useskt the operational mode, position 2 is

used to enable/disable configuration bypass, argltipo 3 is used to select the serial

communication rate. Position 4 is reserved fourieituse. See Table 5 on the next page for
switch settings.

e

=l

P

]
|
ol |

== U] | 0]

]

Figure 57:  3500Pro S1 (Operational Mode/Config Bypes/Comm Rate)
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4.4.2

4421

4.4.2.2

4.4.2.3

4.4.2.4

3500Pro Switch Operational Descriptions

Table 5: 3500Pro Switch S1
3500Pro S1 Switch Switch Switch Switch
Operational Mode/ S1-1 S1-2 S1-3 S1-4
Config Bypass/Comm Rate

Software Upgrade Mode ON
Normal Operation Mode OFF
Configuration Bypass Enabled ON
Configuration Bypass Disabled OFF
COM 1 Rate: 38400 Baud ON
COM 1 Rate: 9600 Baud OFF
Reserved — Set S1-4 to OFF OFF

S1-1 Operational Mode

This switch is used to place the 3500Pro into safenupgrade mode for use with Load3500,
the software installation utility. For more infoation on the use of Load3500, consult the
technical bulletin that came with your software tgute.

For normal operation, this switch should be in@&= position.

S1-2 Configuration Bypass

For normal operation, this switch should be in@#F- position. For information on using the
configuration bypass feature, see “Configuratiopdss” on page 50.

S1-3 COM 1 Rate

This switch is used to select the communications used by COM 1 on the 3500Pro. The
communication rate for COM 2 is determined by sgtimade in the 3500Pro software.

S1-4 Reserved

S1-4 is reserved for future use.
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4.5

451

4.5.2

4.5.3

SUBASSEMBLY INSTALLATION

Model 3500Pro-S

The 3500Pro-S consists of an external chassis 80@Pro System Controller board. There is
no internal power supply.

The 3500Pro System Controller board is installethechassis as follows:
1. Align the board support tray with the card gsidethe chassis.

2. Carefully, insert the board into the chassidl il connectors on the board make contact
with the connectors on the backplane. If possibiepect the mating connectors to
ensure proper alignment.

3. Firmly, push the board into the chassis unglltbard connectors are fully mated with the
backplane connectors. If the contact insertiosdmeems excessive, gently push up on
the bottom of the board with one hand, while puglon the front of the board with the
other.

Model 3500Pro-D, Model 3500Pro-SE, and Mode 3500Pro-DE

The 3500Pro-D consists of an external chassis woB6500Pro System Controller boards and
two PS130 Power Supplies. It may also be ordesetha 3500Pro-SE, which has only one
3500Pro System Controller board and one PS130 PSweply installed in the same chassis.
The 3500Pro-DE is the expansion kit required toveoina 3500Pro-SE to a 3500Pro-D.

3500Pro System Controller Board Installation
The 3500Pro System Controller boards are instali¢de chassis as follows:
1. Align the support tray of the first board with tt&rd guides in the chassis.

2. Carefully, insert the board into the chassis uhgl connectors on the board make contact
with the connectors on the backplane. If possibiepect the mating connectors to
ensure proper alignment.

3. Firmly, push the board into the chassis until tbarkd connectors are fully mated with the
backplane connectors.

4. Repeat the above steps for the second board.
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454  PS130 Power Supply Installation

A fully configured 3500Pro-D contains two PS130 Posv Supplies connected
in parallel. Either power supply is capable of powring both system
controller boards, with the second power supply seing as a backup for the

first. One power supply may be removed and replacewvhile the other is
connected to the power source, and the 3500Pro-Daperational.

The PS130 Power Supplies are installed in the chasdollows:
1. Align the shield plate of the first power supplith the card guides in the chassis.

2. Carefully, insert the power supply into the amsuntil the connectors on the power
supply make contact with the connectors on the flacdle. If possible, inspect the mating
connectors to ensure proper alignment.

3. Firmly, push the power supply into the chassisl uhe power supply connectors are
fully mated with the backplane connectors, and poger supply latch engages the
corresponding slot in the chassis.

4. Repeat the above steps for the second powelysupp
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Chapter 5 - Operating the System
Controller Hardware

5.1 GENERAL
This equipment is to be controlled by the 3500Panttdl System software. For detailed
operational information, consult Section lIl.

Figures 58 and 59 show typical views of the 35008ystem Controller board. The
configuration shown is that used in Models 3500B&80Pro-D, 3500Pro-SE, and 3500Pro-DE.

Other models use a different support tray; bubperated in the same way.
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Figure 58:  3500Pro System Controller Board Assemblyop View

O © @
@ @ @ :
GND +5V  +BATTERY RUN. ACTIVE RESET  MODE

Figure 59:  3500Pro System Controller Board Assemblffront View
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5.2 FRONT PANEL SWITCHES

521 Reset (S2)

This SPDT momentary pushbutton switch is used towualy reset the 3500Pro System
Controller in the event of system failure or lockigpmilar to a warm boot on a PC). To reset
the controller, press and hold this switch for alibtee seconds.

522 Mode ($4)

This SPDT toggle switch is used in a dual contradgstem to designate, which controller is
the primary controller, and which is the backuptoalier. Set the Mode switch to ACTIVE on
the primary controller, and to STANDBY on the baglaontroller.

In a single controller system, this switch has fiect

5.3 FRONTPANEL LEDs
See “LEDs” on page 51.
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Chapter 6 — Maintenance and Repair

6.1 PERIODIC MAINTENANCE

There are no periodic maintenance requirementthigrequipment.

6.2 CONFIGURATION BYPASS

If the configuration being used by the 3500Pro &ysController becomes corrupt, it may be
bypassed to allow the loading of another configareas follows:

1. Remove power from the 3500Pro.

2. Remove the 3500Pro from the chassis to allow adoeswitch S1 (see Figure 57 on page
44). Set switch S1-2 to the ON position in accoogawith Table 5 on page 45.

Reinstall the 3500Pro and apply power.

Load the new configuration. This will overwrite tberrupted configuration.
Remove power from the 3500Pro.

Remove the 3500Pro from the chassis and returels\8it-2 to the OFF position.

N o g~ w

Reinstall the 3500Pro and apply power.

ON /77N ZQ\ACTIVE
® @6 920 @.0 @..
GND +5V +BATTERY RUN ACTIVE garTeRy RESET  MODE

Figure 60: 3500Pro System Controller Board Assemblffront View

6.3 FRONT PANEL TEST POINTS

6.3.1  3500Pro System Controller Board

The 3500Pro System Controller board has threepesits accessible from the front panel,
GND, +5V, and +BATTERY, as shown in Figure 60.

6.3.2 GND (TP17)
This test point provides a convenient ground wheasuring voltages at the other test points.

633 +5V (TP18)

The voltage measured between this test point an® GI\P1) is the output of the voltage
regulation circuit and should be 5VDC, +0.1VDC.
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6.3.4 +BATTERY (TP19)

The voltage measured between this test point and GN¥1) is the output voltage of the
backup memory power source and should be >2VDC vgwerer has been removed
from the board. This voltage is stored in a “sugap” and has limited capability to retain
memory for more than 48 hours.

6.4 LEDs

In the rare event this equipment fails to operatgectly, check the appropriate LEDs listed
below for information concerning operational status

6.4.1  3500Pro System Controller Board

The 3500Pro System Controller board has two framepLEDs, RUN and ACTIVE, as shown
in Figure 60 on the previous page.

LED Color Panel Normal Troubleshooting Info
Legend State
LED1 RED N/A OFF Controller board is in reset state or is in progrfam
download mode.
LED2 GRN RUN ON Indicates that input voltage tosthioard is within
design parameters.
If LED is OFF:

1. Remove and reinstall board to verify backplg
connector is properly seated.

2. Check power supplies for proper operation.

3. Contact PESA Customer Service.

LED3 YEL ACTIVE ON Indicates that the board is cemtly in active contro
of a routing switcher system.

In a dual controller system, the primary controller
ACTIVE LED will be ON and the backup controller
ACTIVE LED will be OFF.

If the LED is OFF:

1. Remove and reinstall board to verify backplane
connector is properly seated.

2. Ensure the board has been configured tg be
active.

3. Contact PESA Customer Service.
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6.4.2  PS130 Power Supply

LED | Color Panel Legend Normal Troubleshooting Info
State
D27 | GRN n/a ON Indicates that output voltage ishimit

design parameters.

If LED is OFF:

1. Check input power connections.

2. Check internal fuse (3.15A
250VAC)

3. Replace the power supply.

4. Contact PESA Customer Service

6.5 PESA CUSTOMER SERVICE

If the troubleshooting information above has notvet your problem, contact the PESA
Customer Service Department. Skilled techniciamsaailable to assist you 24 hours per day,
seven days per week.

Detailed contact information for the Customer SmevDepartment is located inside the front
cover of this document.

6.6 REPAIR

Before attempting to repair this equipment, pleasesult your warranty documents and/or the
PESA Customer Service Department. Unauthorizednepsy void your warranty.

@ The PS130 Power Supply assemblies in this equipmeate not field/user

serviceable. These offline switching power supplieontain internal voltages
that are not isolated from the AC power source. Tay should only be
serviced by qualified service personnel using apppriate equipment.
Because of this, it is strongly suggested that powsupplies be returned to
the PESA Customer Service Department for service.

Many of the PC boards in this equipment contain lage numbers of SMT
(Surface Mount Technology) components. Special ttso are required to
replace these components without causing damage aojacent areas. It is
strongly recommended that PESA Customer Service beonsulted prior to
attempting to repair any of the PC boards in this guipment

éTIDN
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6.6.1 Replacement Parts

Only parts of the highest quality have been usedhe design and manufacture of this
equipment. If the inherent stability and relidlilare to be maintained, replacement parts must
be of the same high quality. For this reason, wggest that you consult our Customer Service
Department before installing any parts not purctidsam PESA.

6.6.2  Factory Service

Before returning any equipment to our factory farvice or repair, please contact our
Customer Service Department for an RMA number.

Detailed contact information for the Customer SsviDepartment is located inside the front
cover of this document.
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Section Ill: Software Reference Guide

This section describes the 3500Pro software and toouwse the software. The following modules are
described:

o 3500Pro Configuration Editor: Defines the environment under which the controtesysoperates.

e 3500 Pro Status:Provides a way to monitor the status of the syséamwell as providing a
selection of diagnostic tools..

e 3500 Pro User Manager:Sets up the PC communications and allows you taterand edit users
who can access the 3500Pro software.

e Runtime Database Initialization: Provides a fresh copy of the runtime databases fasashline
monitoring of the router.

For further information, refer to the descriptions in Chapter 7 on the next
page.
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Chapter 7 — 3500Pro Configuration Editor

This section describes in detail each commandahailin the software, and how the command is
integrated into the overall workflow. This sectibagins with a general overview of a typical
workflow you might use when just getting startedhvthe 3500Pro software.

The 3500Pro software is designed for users whoimr@gmore control levels, components,
sources, destinations, and tielines. The 3500&yarels upon its proven capabilities to bring you
the industry's easiest and most comprehensiveat@alution. The graphic-oriented, point-and-
click interface permits error-free, offline/onlisenfiguration and editing.

This section describes both the 3500Pro and the 3BProLE. The
3500ProLE has a smaller feature set and is designddr customers with

smaller systems.

There are seven modules in the software. To aesessmodule, sele8tart > Programs >
PESA 3500Pro Vx.x (whereVx.x is the version) and then, select the module yont waopen.

3500Pro Configuration Editor: Defines the environment under which the controtesys
operates.

3500 Pro Help: Provides user-friendly help tools.

3500 Pro Status: Provides a way to monitor the status of the systgra(d provides
troubleshooting/diagnostic tools.

3500 Pro User Manager: Sets up the PC communications and allows you taterand
edit users who can access the 3500Pro software.

3500Pro Db Admin: Database administration tool that provides us#fubleshooting
information, version of MSDE, Version of databassfws databases to be closed when
inadvertently left open, and allows runtime dat&bagialization to be performed.

3500Pro Db-to-Textfile: A utility that is used to convert earlier versidatabase (*.db)
files to a text (*.txt) file. Text file(s) may beported into the current version’s database.

Runtime Database Initialization: Provides a fresh copy of the runtime databases fesed
online monitoring of the router.
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7.1

7.1.1

7.1.2

7.1.2.1

How 10 Use THE 3500PRO

Setup Overview

This section describes how to use the 3500Prottaseonfiguration files to interface with
3500Pro Controllers. When you are starting yoldd@850 setup, the following represent the
main workflows that you will need to follow:

e Setting up your computer
e Initializing the Databases
e Creating 3500Pro Users
o Creating a New Configuration
OR
e Importing an Existing Configuration
e Downloading the configuration to the controller

Each of these sections provides general inform&toryour workflow. The following sections
provide in-depth information about the differergpst in the workflow.

Time Saving Tools
The 3500Pro provides many new, timesaving optibas nake it much faster for you to enter
repetitive information into your configuration.

Right-click mouse commands

For many fields that require you to enter repegitinformation, such as Inputs, Outputs, etc.,
there are additional commands available if you kclibe right mouse button. These
commands vary depending on the window you are wgrkiith:

AutoMurnber

Copy
Cut

Paste

Copy Increment
[nsert

Export to C5V File

Fill-Llp
Fill-Dovn
Fill-Left
Fill-Right

Tigline Source Define
Eraperties

Figure 61:  Right-click mouse commands
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7.1.2.2

7.1.2.3

7.1.2.4

Autonumber

Automatically numbers selected fields, startinghwiihe number at the top of the selected
column. For example, if you select a range ofd8elith a “1” in the top field, then select
this command and they will automatically numbee(B&gure 62):

e =R B R TR R

Figure 62:  Autonumber

Cut, Copy, Paste
This activates th€ut, Copy, andPaste commands.

Fill-Up

This fills in fields above a selected field withetlsame information. First, select the field
with the number you want to duplicate and thereaethe fields above it. Right-click and
selectFill-Up to fill in the fields with the selected informatigsee Figure 63).

h h v Lh

Figure 63:  Fill-Up
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7.1.25 Fill-Down

This fills in the fields below a selected field tithe selected number. First, select the field
with the number you want to duplicate and therectdhe fields below it. Right-click and
selectFill-Down to fill in the fields with the selected numberddagure 64).

h o Gh | Ch Lh

Figure 64:  Fill-Down

7.1.2.6 Fill-Left

This fills in the fields to the left of a selectBeld with the selected number(s). First, select
the fields with the numbers you want to duplicatd then, select the fields to the left. Right-
click and seleckFill-Left to fill in the fields with the selected numbergou can select either
one field or several fields with this option (segufe 65).

o R -r RS R PR
R - R, R FL R L Y

Figure 65:  Fill-Left
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7.1.2.7  Fil-Right

This fills in the fields to the right of a selectkeld with the selected number(s). First, select
the fields with the numbers you want to duplicatel @hen, select the fields to the right.
Right-click and seledgill-Right to fill in the fields with the selected numbergou can select
either one field or several fields with this opti@ee Figure 66).

b R -r RS R FE R L R
= N e LD P e

Figure 66: Fill-Right

7.1.2.8 Delete Rows
This deletes the selected rows. You only havelkecs one item in a row to delete it.

Make sure you really want to delete the row beforselecting this command.
You cannot "Undo" this action.

7.1.29 Clear Selected
This removes information from the selected fieldisgs not delete the row).

7.1.2.10 Clear All

This removes information from the entire window.
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7.2  GETTING STARTED
The first thing you need to do with the 3500Prawsafe is to define the serial port connection
and the baud rate.
1. Connect the computer that has the 3500Pro addtyrogram installed to the COM1
Connector on the 3500Pro Controller using a 9-gi.N modem RS232 cable.

2. Select Start > Programs > 3500Pro > 3500Pro User Manager. The 3500Pro
Connection/User Manager window displays (see Figure 67).

=13

3500Pro Connection,/User Manager

File Help

™ Serial Port Connection

COm Port: [Selm - Baud Rate: E=rmn -

Controller Address:  FERN =Rk TCP Port:  Elugl

Present Connection: hrough COMA at 33400 Baud.

Figure 67: Connection Tab

3. In theConnection Parameters section, make sure there is a check mark nexte&é¢rial
Port Connection option.

4. In theCOM Port pull-down window, select the COM port you are gsto connect to the
3500Pro Controller.

5. In theBaud Rate field, select the baud rate you want to use. Gdnad rate is defined by a
dipswitch setting on the Controller board. Retetite 3500Pro Controller documentation for

details.
6. SeleciCommit to save your changes.
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7.3 INITIALIZING THE DATABASE

After setting up your computer, initialize the cignfration and runtime databases. To
accomplish this, sele&tart > Programs > 3500Pro > Runtime Database Initialization. This
will purge any old runtime databases from your eystand makes a new copy of the master

database.

7.4  CREATING USERS
After your computer is properly configured, you ameate users for the 3500Pro software.

User accounts are optional. If used, at least oneser account must be
assigned all privileges. If no user accounts arenfigured, all users have all

privileges.

1. If the 3500Pro Connection/User Manager windowdsopen, selectart > Programs >
3500Pro > 3500Pro User Manager. The 3500Pro Connection/User Manager window

displays.
2. Select théJsers tab (see Figure 68).
=101 x|

3500Pro Connection/User Manager
File Help

Caonnection Path Options

Ayailble Users:

Figure 68: Users Tab
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74.1  Createa User With Accessto Everything
1. First, you need to create a user who has atces®rything in the system. Select the
Add>> button to start.
In theUser Name field, type in a name for the user.
Select th&et Password button to define a password for the user.

Type in the password you want to use inNlesv Password field. Re-enter the exact
same password in ti@onfirm New Password field.

You must enter the exact same password in both fis!

5. SelectOK to accept the new password. The password winditvchase, and you will
return to the User Manager window.

6. Now select th&et All button and check marks will display next to eatdf This
means that the user will have access to everythititge 3500Pro software.

7. SelectCommit and the user will be added to the system and vaflldy in the Available
Users box on the left side of the window.

74.2  Createthe Rest of the Users
1. Now, you can create additional users with actesspecific sections of the software.
Select theAdd>> button.

. Enter &Jser Name.
3. Select theSet Password button and enter a password. Sel& to accept the
password and close the password window.

4. Now, select the specific sections of the sofempou want the user to be able to access.
When you are finished, sele€ommit and the user will be added to the system and will

display in theAvailable Users section.
5. Repeat this process for as many users as negessa
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7.5 CREATING A NEW CONFIGURATION

If you do not have an existing configuration filu need to create one. You will use the
Configuration Editor to create a configuration file.

751 Createa New Configuration File

1. SelectStart > Programs > 3500Pro > 3500Pro Configuration Editor. The
Configuration Editor window is displayed.

2. SelectFile > New Configuration Database to create a new database on your computer.
Select the directory location for the file, entemame and then, sele€@K. A new
configuration file will be created on your computéfhe name of the file will display at
the top of the window.

There is a sample configuration test file providedn the 3500Pro software
installation compact disk (CD). You may import ths file into a

configuration database to become familiar with somef the configuration
options. To import the file, perform the following steps:

1. SelectFile>Transfer Configuration...

2. When the Transfer window appears, select the Import
Configuration From ASCII File radio button and then, click on the

Execute function button.

3. When the File Open window appears, navigate to the drive
containing the 3500Pro software installation CD andhen, click on
the Cougar Combo Numeric.txt file to highlight it.

4. Click the Open button. The configuration text file will be imported
into the database.

7.5.2  Setting Up The Configuration File

Each configuration file will be different dependiag the specific configuration you are working
with. However, the following are some basic stiéfad are common to each configuration file.

1. SelectConfiguration > System Configuration > Level/Comp to set up Levels and
Components.

2. SelectConfiguration > System Configuration > CPU Link/Port to set up serial
communications link to the controller.

3. SelectConfiguration > Matrix Configuration to define sources and destinations that
match the equipment connected to the router.

4. SelectConfiguration > Panels to define the settings for different RCP remotetoa
panels in your system.
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7.5.3  Optional Features Setup

The remainder configuration commands are optioepkedding on how you want to set up your
system. If you choose, you can define the follgnaptions:

1. SelecConfiguration > Salvo to define salvos.

2. SelecConfiguration > Categories to define categories.
3. SelecConfiguration > Tielines to define tielines.

4. SelecConfiguration > Reentry to define reentries.

7.6 IMPORTING AN EXISTING CONFIGURATION

If you have an existing configuration file from atder version of 3500, yogan import it into
the software.

7.6.1 Importing an ASCII File

Make sure you have the configuration file on yoaimputer and stored in ASCII formé@txt or
.dat extension).

1. SelectStart > Programs > 3500Pro > 3500Pro Configuration Editor. The
Configuration Editor window displays.

2. SelectFile > Transfer Configuration (see Figure 69)

Configuration Transfer

Configuration Transfer Options

B Prompt befurs taking the controller oifline

Configuration Transfer Actions

# Download Configuration TO Controller
#® Upload Configuration FROM Controller
® Export Configuration to ASCI file

@ Import Configuration from ASCII file

Figure 69: Import a Configuration from an ASCII Fil e
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Select thdmport Configuration From ASCII file button, then seledxecute.

The Import window will display. Change to the directory whehe configuration file
you want to import is located. Select the file @etbct thedpen button.

5. The messagenporting Text File displays. When the process is complete, the rgessa
“Import is Complete” displays. You can now work with the configuratible.

7.6.2 Uploading The Current Configuration

If you have a system already set up you can jusd khe existing configuration file from the
3500 Controller to the 3500Pro software.

1. SelectStart > Programs > 3500Pro > 3500Pro Configuration Editor. The
Configuration Editor window displays.

2. Select File > Upload Configuration From Controller. If a configuration file is
currently open, the following message displays tSgare 70):

3500Pro Configuration Editor x|

Uplnading the controller configuration will overwrite configuration being editted.
Do you wank to conkinue?

Cancel |

Figure 70:  Confirm Configuration File Upload

3. The current configuration will be loaded to the @B software, and you can then save
the configuration to your computer and start wogkivith it.

7.7 DOWNLOADING THE CONFIGURATION TO THE CONTROLLER
After you are done creating your configuration,fifeu need to download it to the controller.
1. From theConfiguration Editor window, selecFile > Transfer Configuration.

2. Select theDownload Configuration TO Controller option, then selecExecute. The
following prompt displays (see Figure 71):

3500Pro Configuration Editor x|

This will change the configuration in the contraller,
Do wou wish bo conkinue?

K, I ancel

Figure 71:  Download Configuration Prompt
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7.8

3. If you are sure you want to download the configion file, selecOK.

4. The following prompts display in the Status Bathe bottom of the window:

Exporting the configuration to a file.
Downloading to the Controller

Committing the Configuration to Flash

5. The configuration file will be sent to the caiker and you can then use additional 3500Pro
tools to monitor the controller and perform diagioss

The controller is non-operational while it is commiting the configuration to

You have now established a basic connection wihstfstem controller. Continue to modify and
customize your configuration file and upload thenfeguration file to the controller. The
following chapters provide in-depth information aboeach command available in the

Configuration Editor.

3500PRO CONFIGURATION EDITOR FILE MENU

The File menu (see Figure 72) provides tools to open, selese, upload, and download
configuration files. In addition, there are totwamport ASCII files and export to a database.

Mew Configuration Database. .. Zkrl+Hh
Cpen Configuration Database. .. Chrl+0
Close Configuration Database!

User Lagin. ..

Controller Status, .,
Clear Configuration Locks
Reset Contraller

Yalidate Configuration. ..
Transfer Configuration, ..

Incremental AddfEdit. ..

Save Configuration Database
Save Configuration Database As, .,

Exit:

Figure 72:  Configuration Editor File Menu
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7.8.1 Shortcuts

There are several "shortcuts" available to quicktgess commonly used commands. The
following shortcut keys and buttons are available:

o Keys:

To use the following shortcuts, press the Conttdflf key and the additional letter at the
same time.

Ctrl+N: File > New Configuration Database:
Ctrl+O: File > Open Configuration Database:
Ctrl+X: Edit > Cut:

Ctrl+C: Edit > Copy:

Ctrl+V: Edit > Paste:

e Buttons:

QI Accesses thEile > New Configuration Database command
E"'I Accesses thEile > Open Configuration Database command

El Accesses th&ile > Save Configuration Database command (if you have
already save the configuration file) OR thave Configuration Database As
command if you have not saved the configuratia fil

Accesses thedit > Cut command

3
Accesses thEdit > Copy command
2

Accesses thedit > Paste command
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7.8.2  New Configuration Database

TheFile > New Configuration Database command creates a new 3500Pro configuration file.
Configuration files contain all of the informatioequired to communicate with the 3500Pro
Controller.

o Creating a New Configuration Database

When you select this command, tRew Config Database window displays. Select a
location for the new configuration file, and engefile name. Sele®@pen, and an empty
configuration will be created. The new configuratfile is automatically saved to your
hard drive to the directory location and file naye® entered. If a configuration file is
currently open, you will be given the option to sar discard any changes that you have
entered before making a new configuration filewati

After you have entered all of the information désag your Routing Switcher into the
new configuration file, you can use th#ge > Download Configuration TO Controller
command to load the configuration file to the colhér.

7.8.3  Open Configuration Database

The File > Open Configuration Database command EI"| opens a previously saved
configuration file list (see Figure 73).

Before using this command, you must have a valid ofiguration file
available on your computer or computer network. Ifyou need to access a

configuration file stored on a controller but is nd on your computer, use
the File > Configuration Transfer > Upload Configuratio n FROM

Controller command.

New Config Database illl
Look jn: I@doug j = ci E-

[=]1.db | test515.db
importtext, db @ testcfg.db
it b ] testefg@.db
jp.db Ql tielines,db
[®] may1z.db ] et b
new,db 9 uploadtest.db
new?.db Q workFlow, db
new429.db Q yireyrey.db
newtest,db

t1.db

test.db

File name: I j Open I
4 Cancel |
FA|

Filez of type: |Eonfig Database Files [*.db]

Figure 73:  New Configuration Database
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7.8.4  Close Configuration Database
TheFile > Close Configuration Database! command closes the active configuration file.
Before using this command:
e Close all of the open windows.

e You will have the option to save the configuratile with either theFile > Save
Configuration or File > Save Configuration Database As commands before closing
the file, otherwise you will lose your changes.

7.85 Controller Status

The File > Controller Status command verifies the communication to the corgroll The
command displays a window with the name and versimmber of the controller software.
SelectOK to dismiss the window (see Figure 74).

3500Pro Configuration x|

*Text Varies with the

PESA Controller is: 3500Fro, BetaSa o
controller that isin use.

]9

Figure 74:  Controller Status Message

If there is a problem with the connection to thatcoller, the following message will display
(see Figure 75):

3500Pro Eunﬁguratiu: x|

Unable ko access contraller,

Ik

Figure 75:  Controller Status Error Message

If you get this error, ensure that the physicalr=mtions to the controller are in place. Refer to
your 3500Pro Controller Manual for detailed infotimoa about hardware setup.

e Before Using this Command

Connect the computer that has the 3500Pro softweogram installed to the COM1
Connector on the 3500Pro Controller using a 9-piLN Modem RS232 cable.
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7.8.6

7.8.7

7.8.8

Clear Configuration Locks

In the rare event that a power failure, hardwardfunetion, or other occurrence prevents a
configuration upload or download from terminatimga normal manner, the configuration lock
may latch in place. To manually clear a configiratock, selecFile > Clear Configuration
Locks.

If the malfunction occurred while downloading a figaration to the controller (sometimes
referred to as writer’s lock), the controller walso be reset. You will be warned in this event.

Reset Controller

In the event that it is determined the controll@rdware should be reset, this function provides
a mechanism to reset the system without pressagcatual reset button (switch) located on the
controller card. You will be prompted to verifyathyou understand the impact of what is about
to be performed.

Validate Configuration

The File > Validate Configuration command checks the currently open configuratientt
make sure it does not contain any errors. Use toisimand before transferring the
configuration file to the controller.

You can also validate the configuration before gownload or export the configuration with
the “Validate” option in th@ransfer Configuration window (see Figure 76).

Configuration ¥alidation

Performing Validation...This may take a couple of minutes.

Ohject Type Object ldentifier Error Description

Figure 76:  Validate Window
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7.8.9  Transfer Configuration

TheFile > Transfer Configuration command provides a way to transfer a configurdilerto
the controller, upload a configuration file stored the controller, and to import and export
configuration files to and from ASCII files (seegbire 77).

Configuration Transfer - O] x|
Configuration Transfer Options

ure DownluafEzpurt

B Prumpt be Y the couniruller offling

Configuration Transfer Actions

#® Download Configuration TO Controller

® Upload Configuration FROM Controller F
® Export Configuration to ASCII file

@ Import Configuration from ASCII file

Figure 77:  Configuration Transfer Window

7.8.9.1 Before Using This Command

e If you are uploading a configuration file from tkentroller, close any configuration
files you are currently working with.

e If you are importing a configuration from an AS@ile, make sure the file you want to
use is stored in a location you can access.

7.8.9.2 Configuration Transfer Options:
The following options are available in this window:

1. Force Router Switches After Download: After downloading a configuration file to
the controller, automatically performs switches.

2. Validate Configuration before Download/Export: Validates the configuration file
before you download it to the controller to expotb a file.

3. Prompt Before Taking the Controller Offline: Displays a message box informing
you that the following procedure will take the aatier offline.
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4. Configuration Transfer Actions: For detailed information about each of these
options, see the following sections.

e Upload Configuration FROM Controller (Section 7.8.9)
e Download Configuration TO Controller (Section 7.8.10)
e Import ASCII File TO Database (Section 7.8.11)
e Export Database TO ASCII File (Section 7.8.12)

5. Execute: Performs the action you selected in this windéfter you select Execute,
messages will display in this window to let you wnthe progress of the selected
action, and when the action is complete.

7.8.10 Upload Configuration FROM Controller

TheFile > Upload Configuration FROM Controller command uploads a configuration from
the 3500Pro System Controller to the PC.

7.8.10.1 Before Using This Command

This command overwrites the configuration inforratin the 3500Pro Configuration Editor.
To avoid data loss, be sure to save and/or clasedhfiguration currently open in 3500Pro
before overwriting it with the uploaded configuoeti

7.8.10.2 Uploading a Configuration from the Controller

When you select this command, the following messatjsplay in the Status Bar at the
bottom of the 3500Pro window:

e Pulling the configuration from the controller
e Importing the configuration into the database

e Configuration Upload is Complete

If a status bar does not display at the bottom oftte window, select View >
Status Bar.

After the process is complete, the configuratioritiregs will be available in the
Configuration Editor.
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7.8.11 Download Configuration TO Controller

TheFile > Download Configuration TO Controller command downloads a configuration file
from your computer to the controller.

7.8.11.1 Before Using This Command
e Save the configuration file on the controller befdownloading a new file.
e Create or Open the configuration file you want $e with the controller.

e Save the configuration file before downloading it.

This command causes the controller and switchers tde temporarily
unavailable until the download is complete.

CAUTION

7.8.11.2 Downloading a Configuration to the Controller
When you select this command, the following proripplays (see Figure 78):

3500Pro Configuration Editor x|

This will change the configuration in the controller.
Do wou wish bo continue?

OF I Cancel |

Figure 78: Download Configuration Message

If you are sure you want to download the new camfigion, selecOK. The following
prompts display in th8tatus Bar at the bottom of the window:

e Exporting the configuration to a file
e Downloading to the Controller
e Committing the Configuration to Flash

e Configuration Download is Complete

The configuration file will be sent to the conteslland you can then use additional 3500Pro
tools to monitor the controller and perform diagioss
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7.8.12 Import ASCII File To Database

TheFile > Import ASCII File to Database option imports an ASCII configuration from the
PC into 3500Pro. If you have a configuration fitem an older version of 3500, you can
import the ASCII .txt file into this version of tleftware.

A configuration may exist in two different formats:

1. A DB configuration is stored as db. style database. This is the format that 3500Pro
uses when storing a configuration on the PC.

2. An ASCII configuration is stored as an ASCII ttdde (.txt). 3500Pro converts a
configuration from an ASCII text file to a DB filwhen it is uploaded from a 3500Pro
system controller or imported from an ASCII texefi

7.8.12.1 Before Using This Command

A configuration file must be open before you campart an ASCII file. Open an existing
configuration file or create a new configuratiole fi

If you import the ASCII text file into an existing configuration file, the
current configuration will be overwritten.

7.8.12.2 Importing an ASCII File
1. When you select this option, tmeport window will be displayed.

2. Use thd.ook in drop-down list to select the directory where tloafguration file is
stored. The available files will display in the miié part of the window.

Select the file you want to import and theneseDpen.

The configuration settings will be imported intee software and you can review the
information with the menus.

7.8.13 Export Database To ASCI| File

TheFile > Export Database to ASCII File exports an ASCII configuration from 3500Pro to
the PC.

A configuration may exist in two different formats:

1. A DB configuration is a configuration storedaa.db) file extension. This is the format
that 3500Pro uses when storing a configuratiorherPC.

2. An ASCII configuration is a configuration storasl an ASCII text file. 3500Pro converts
a configuration from DB to ASCII when it is downhbed to a 3500Pro System Controller
or exported to an ASCII text file.

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 74



§§ PESA 3500PRO/LE — SECTION 111

81-9059-0549-0 Rev. E

This option is useful if you need to transfer tla¢atbase file to another computer, or easily look
at the data in the database. You can open the IAB€Iin a simple text editor or a word
processing program such as Microsoft Wotd review the information. If you open the file,
just make sure you do not change the file extenGizt).

7.8.13.1 Before Using This Command
e The configuration file you want to export must lpen.

e Save the configuration file before you export it.

7.8.13.2 Exporting a Database File
1. When you select this command, Export window will be displayed.
2. Use the&save in drop-down list to select the directory where yaanwo save the file.

3. Then, type a name in tiide name field. SelectSave and the file will be saved to
your computer.

7.8.14 Save Configuration Database

TheFile > Save Configuration Database (= command saves the configuration file to your
hard drive (or network).

If this is the first time you have saved the coufgion file, theSave Config Database As
window will be displayed. You can then enter a ador the file and select a location to save
the file.

e Before using this command, a configuration file triues open.
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7.8.15 Save Configuration Database As

TheFile > Save Configuration Database As El command allows you to enter a name and
directory location for the configuration file, atften saves the file to the specified location (see
Figure 79).

Save Config Database As 2=

Save in: Iﬁ Caonfiguration j L] ﬂ‘ -

My Documents

File harne: I j Save

N Save as tupe: IEonfig Datahase Files [* db) j Cancel /l
%

Figure 79:  Save Configuration Database As

If this is the first time you have saved the configration file, the Save
Config Database As window will automatically display.

Use this command to save an existing configuratiofile to another file
name or directory location.

<4 4

e Before using this command, a configuration file triues open.

7.8.16 Exit
TheFile > Exit command closes the 3500Pro Configuration Editor

e Before using this command, save the configuratiernybu are working with.
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7.9 CONFIGURATION EDITOR EDIT MENU

TheEdit commands allow you to cut, copy, and paste inftionan the 3500Pro workspace. The
following commands are available (see Figure 80):

_uk

Copy
Paste

Panel Template. ..
Download Mode

Figure 80:  Edit Menu

791  Cut

TheEdit > Cut il command removes information from a setifiedd or fields (see Figure
81). To use this option, you must highlight areatteat contains information you want to "cut".
When the area is highlighted, as shown below, s#iéccommand and the information will be
removed and placed on the “clipboard" (temporasgesfe location on your computer).

Name ‘ Src# ‘ VIDEOD ‘ LevXX10
_|CAM 11 26 11
_ |CAM 12 27 12
_|cAmM 13 28
_ |CAM 14 29 14
_ |CAM 15 30 15
__|CAM 16 N 16
_|CAM 17 32 17

Figure 81:  Highlighted Field
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“" TIP: If you need to remove the information from an entire column, highlight the entire
column. Select thefirst field you want to cut, then hold down the left mouse button
and move the cursor so all of the fields you want to cut are highlighted. Then,
select the Cut command and all of the information will be removed (see Figure 82).

Hame ‘ Src# ‘ VIDED

LewXX10

ER
EE

ZI]

_|cam 11 26
_ |CAM 12 27
_ |CAM 13 28
_|cAamM 14 29
_ |CAM 15 30
_ |CAM 16 3
_|[cam 17 32
__|CAM 18 33
_ |[cAaM 19 34

CAM 20 35

Figure 82:

Highlighted Column

If you Cut information, you cannot "Undo" the action. Make sure you cut
the correct information. If you accidentally cut the wrong information,

immediately use theEdit > Paste command to replace the cut information.

Each time you use the "Cut" or "Copy" command, the information stored
on the clipboard will be overwritten.

“~ TIP: In many 3500Pro windows, you can also access this command by clicking the right

mouse button. A menu will display, and you can select Cut.
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79.2  Copy

. Eg . N . . .

TheEdit > Copy command copies highlighted informatiorthe clipboard (a temporary
storage location on your computer). Then, you Paste the information into another
location. This saves time when you have to typermation in several different places.

To copy information, select a field. When it hiigthits, as shown in Figure 83, sel€zpy and
the information will be pasted to your clipboard.

Name ‘ Src# ‘ VIDEQ ‘ LevXX10
_|CAM 11 26 11
_|CAM 12 27 12
Ccmn
_CAM 14 29 14
__|CAM 15 o 15
__|CAM 16 M 16
_|CAM 17 32 17

Figure 83:  Highlighted Field

Each time you use the Cut" or " Copy" command, the information stored
on the clipboard will be overwritten.

“ TIP: In many 3500Pro windows, you can also access this command by clicking the right
mouse button. A menu will display, and you can select Copy.

793 Page

The Edit > Paste El command places information stored on thebowd in the selected
location. Use this command to place information yeither Cut or Copied to a different
location in the 3500Pro interface.

Each time you use the "Cut" or "Copy" command, the information stored
on the clipboard will be overwritten. If you want to "Paste" information,

make sure you do so before overwriting the informaon.

* TIP: In many 3500Pro windows, you can also access this command by clicking the right
mouse button. A menu will display, and you can select Paste.
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794

7.9.4.1

7.9.4.2

Panel Template

TheEdit > Panel Template command allows you to set up defaults for parfermation (see
Figure 84). These settings will be set as a defsadh time you create a new panel (with the
Configuration > Panels option).

Panel Template

Lock Priority _
Requestor Code - ™ Follow Panel Address

Status Method DEF

Status Level LEV1

Include List Preferences

Level List LEVINC1 B ALL Level Include Lists

Source List = ALL Source Include Lists

Destination List [:NE = ALL Destination Include Lists

Salvo List - M ALL Salvo Include Lists

Key List Create Mode (Sources, Destinations, Categories)

< Prompt Before Creating
& Automatically Create
@ Do Not Create

Figure 84:  Panel Template Window

Lock Priority

The lock priority is used with the requester codedéetermine if a lock or protect can be
removed. When a lock or protect has been assigyed panel or port, it can only be
removed by another panel or port with a higher Ipdhrity, or with the same lock priority

and same requester code. The lower the lock tyrioamber, the higher the priority.

Panel lock priorities not explicitly defined autatically default to "0", which gives absolute
authority to clear any lock or protect on the systel'he acceptable range of lock priorities is
shown in the General Specifications Table.

Requestor Code

The requester code is used with the lock prioritydetermine if a lock or protect can be
removed. When a lock or protect has been assiggesl panel (or serial communications
port), it can only be removed by another panepat) with a higher lock priority or with the
same lock priority and same requester code.

Requestor codes are also used with protects. \&hdsstination is placed into protect, only
those panels/users with the same requestor codength the destination.
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7.9.4.3

7.9.4.4

Requester codes that are not explicitly definethraatically default to the panel address.
You can also select th&dllow Panel Address” box to ensure that the Requestor Code is
always identical to the Address.

Status Method

When a panel is in all levels modeL{ LEVS), the status shown will be the source on the
Status Level assigned to that panel. If the das8tn is not defined on the Status Level,
Status Method is used to control the resultingldisp

o If DEF (Default Method) is selectetlO XXXXX will be displayed wher&XXXXX is
the Status Level assigned to the panel.

e If GRP (Group Method) is selected, the controller will exae every level
sequentially, starting with the level designated.egel Order 1. The source switched
on the first level found where the destination &fimed, will be displayed as the
destination status.

Status Level

One function of the LCD display on a panel is towlwhich source is currently switched to
a selected destination. This is known as destinatatus. Although more than one source
can be switched to a single destination (limitedrnie source per level), the status display can
only show one source at a time. When the paniel &l levels modeALL LEVS), Status
Level is used to designate a default level to eelwshen displaying status. Only the source
on this default level will be displayed. Pushbotanly panels also use the status level. It is
used to determine which tally LED to light on a @kin a split/breakaway condition.

For the following items (7.9.4.5 through 7.9.4.8)f you need to find out the
names of current lists, selecConfiguration > Panel . Use the various List

pull-down menus on the far right side of the PaneBSpecific Data tab to
review the available lists.

7.9.4.5

7.9.4.6

Level Include List

The Levels Include List is a named list of all lisvéhe panel (or remote client) is authorized
to control. Enter the name of the list that yontv@ assign to new panels, or selectAhé
Level Include List to assign all of the available levels.

Source Include List

A source include list is a named list of the sosraespecific control panel (or remote client)
is authorized to control. A source include listyntwe shared by multiple panels. Enter the
name of the list that you want to assign to newefsgror select thALL Source Include List

to assign all of the available sources.
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7.9.4.7

7.9.4.8

7.9.4.9

7.9.5

Destination Include List

A destination include list is a named list of trestinations a specific control panel (or remote
client) is authorized to control. A destinatiortlirde list may be shared by multiple panels.
Enter the name of the list that you want to asdigmnew panels, or select th&LL
Destination Include List to assign all of the available destinations.

Salvo Include List

A salvo include list is a named list of the sahagospecific control panel (or remote client) is
authorized to control. A salvo include list maydiered by multiple panels. Enter the name
of the list that you want to assign to new paneisselect theALL Salvo Include List to
assign all of the available salvo groups.

Key List Create Mode

TheKey List Create Mode allows you to reset the default method of handtimg entry of
certain objects into a key list. The objects tihég mode applies to are entered in a key list
and the database is queried to see if they eKigihey do not exist, this setting determines the
action taken. The following mode selections appear

e Prompt Before Creating: This mode will ask you if you want to create tigect.
e Automatically Create: This mode will automatically create the object.

e Do Not Create: This mode will not create the object and you Wwive to manually
create the objects.

Download Mode

TheDownload Mode always defaults to “Compressed Block Download Méth This should
never be changed unless you are unable to dowrloaahfiguration to the controller. The
modes are used in sequence from the fastest muittbe slowest method. The software will
automatically switch down to the next slower metifqaroblems are encountered. The setting
of this mode determines which method the downlodlcstart with.
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7.10 CONFIGURATION EDITOR VIEW MENU

The View commands display or hide the toolbar and status B&e following commands are
available (see Figure 85):

Vigw
v Toolbar
v Status Bar
Figure 85: View Menu

7.10.1 Toolbar

The View > Toolbar command hides or displays the bar with the shontmns. Select this
command to display or hide the toolbar.

7.10.2 StatusBar

The View > Status Bar command hides or displays the bar with the statiesmation that
displays at the bottom of the 3500Pro window. Selkis command to display or hide the
status bar.

7.11 CONFIGURATION EDITOR CONFIGURATION MENU

The Configuration commands define all of the settings in the configon file that allow you to
customize the configuration of your 3500Pro systemtroller. Use these commands to set up
the configuration file and then, download the cgufation file to the controller. The following
commands are available (see Figure 86):

Configuration

Systern Configuration  » R lalelyTa i
Matrix Configuration. .. CPU Link/Port...
Panels... Configuration Info...

Salvo,.,
Categaries. ..
Tielines. ..
Reentry...
Remote Clients. ..

Figure 86:  Configuration Menu

If the configuration menu is “grayed out”, this icates that you do not have a configuration
database open. In tRk@e Menu, create &New or Open an existing configuration database.
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7111 Level/Comp

The Configuration > System Configuration > Level/Comp provides an interface to work
with Levels and Components. The following sectidascribe what levels and components are
and how to work with them.

7.11.1.1 Levels

TheLevels section of the window allows you to add, edit, detete levels (see Figure 87).

Level/Component Configuration

Hame Inputs

| Outputs | Properties

VIDEO

144

AUDIO1
AUDIO 2
AUDIO 3
AUDIO 4
KEY

- =
el RN M RN E

Components
Name

144
144
144
144
144

Level Hame

224
144
144
144
144
224

Input Offset

Chop
Chop
Chop
Chop
Chop
Chop
[] Chop
] Chop
[] Chop
[] Chop

[] Chop
[ 1

Output Offset

Strobe

AUDIO 1

AUDIO 2
AUDIO 3
AUDIO 4
KEY
VIDEO

AUDIO 1
AUDIO 2
AUDIO 3
AUDIO 4
KEY
VIDEO

Figure 87:

0

| 4]« «]a]a]H

3

Level/Component Configuration Window

A level is a group of related components that aiéched together by 3500Pro. Levels are
the lowest element that the user can manipulatieeitontrol system. The maximum number
of levels in a configuration is 16 (8 for the 3500FE). The example shown in Figure 88 is
a 2x2 RGB video level named VID, which is made dighvee components named RED,
GRN and BLU.
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121 212 +— LOGICAL IHPUTS
12 3 45 6 T 84— PHYSICAL INPUTS
Ll L1 1 1 1 1

.-— LEVEL VID
-1 1
RED || | <
— -2 2 'II 1:4— LOGICAL IHPUTS
—— -3 1
GRH
——] -4 2 I vID — 1
T imEe 5 1 I — 2
— 6 2 t
| | — 7 LOGICAL OUTPUTS
— &

T 4 LOGICAL OUTPUTS
PHYSICAL OUTPUTS
Figure 88: 2x2 RGB Video Level

Column Descriptions

e Level # Defines the number for the level. You cannot éus field. If you want to
change the Level #, use the Reorder Levels butfime number implies the order of
levels for use on serial commands and panel operati

e Name Specifies the name of the level. Level names care to eight characters in
length and are constructed using uppercase lethenmpers, and spaces. The first
character must be a letter.

e Inputs specifies the number of inputs associated wighleével. The maximum number
of inputs per level is 1024 (144 for the 3500PraLE)

“” TIME SAVING TIP : If the Input value is the same for several different levels (for
example, 144), type " 144" in the first Input field. Then, select the
number you just entered, and highlight the rest of the fields below
it that have the same value. Click the right-mouse button and select
Fill Down. All of the fields will populate with the same Input
value.

Example: Enter the first Input (see Figure 89).

Level # Hame Inputs
1 VIDED 144
2 AUDIO 1
3 AUDIO 2
4 AUDIO 3
5 AUDIO 4
[y

Figure 89:  Entering an Input
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- TIP:

Levels

Level #

Name |

| Outputs | Pi

1

LT=RE =R N - PR R FU K

ey
=

AUDIO 2
AUDIO 3
AUDIO 4

Figure 90:

VIDEO 144
AUDIO 1

| ™

Autohumber

Copy

Cuk

Paste

Copy Increment

Fill-Up
Fill-Conn

Fill-Left
Fill-Right

Tieline Source Define
Froperties

Fill Down

The highlighted fields are populated (see Figure 91

Level # Hame Inputs
1 VIDEOD 144
2 AUDIO 1 144
3 AUDIO 2 144
4 AUDIO 3 144
5 AUDIO 4 144
[
Figure 91:  Populated Fields

Outputs Specifies the number of Outputs associated viithlevel.
number of inputs per level is 1024 (144 for the @S@LE).

Select the first input and then, highlight the m&sthe Input fields with the same value.
Click the right mouse button and sel&dt-Down (see Figure 90).

The maximum

Use the same method described in the I nputs section to quickly enter Outputs. Or,
if the Outputs values are the same as the I nputs, highlight all of the I nputs and the
corresponding cells in the output column, right-click your mouse and then, select

Fill-Right.

Properties Determines if the level is "Chop Enabled”. $ttbe gray box to enable or
disable Chop". When a red check mark displaghop is enabled.
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Working with Levels

e Adding a Level You can have a maximum of 16 levels (8 with 3%@0ProLE). To
add a level, simply type new level information iatdlank row.

e Deleting a Level To delete a level, click on the information ywant to remove and
press the Delete key. You can delete severalesnati one time by highlighting all of
the fields you want to delete, then pressing thieteekey. When you are done deleting
a level, selecOK. Be sure t&ave the configuration file.

e Reordering Levels To change the Level numbers, selectRie®rder Levels button.
TheChange Level Order window will appear, and you can assign new levehbers
to each available level.

7.11.1.2 Change Level Order

You can change the order of levels with fReorder Levels button. Configuration >
System Configuration > Level/Comp > Reorder Levels). This window displays all of the
definedLevel Names and the_evel Order (see Figure 92).

Change Level Order =of x|

Level Name Level Order
WVIDED
AUDIO 1
AUDIO 2
AUDIO 3
AUDIO 4
KEY

Figure 92:  Change Level Order Window

To change the level number, double-click in thédfigou want to change, and enter a new
level number.

Make sure the cursor is blinking inside the field lefore entering a new leve
number.
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7.11.1.3

The number you enter in this field will be the piogi in this window. For example, if you
enter a "5" in the Level Order field, the Level Namill move to the fifth row in the window.
If another level was already assigned "5", it wilbve down a row to the "6" row.

Components

The Components section of the window allows you to add, edit, @etkte components. A

component is the most basic signal element thatbeaswitched by a system controller.
Components map level inputs/outputs to the acthgs$ipal matrix and are collected under a
level to be controlled by users. For example, ®BRvideo, "Red", "Green", and "Blue" are
components; in stereo audio, "Left" and "Right" ammponents. The example shown in
Figure 93 is a 2x2 RGB video level named VID, whishmade up of three components
named RED, GRN and BLU.

121 21 2 +4— LOGICAL INPUTS
1 2 3 4 5 6 7 8 +— PHYSICAL INPUTS
L1 1 1 1 1 1 |

~— LEVEL VWID
—1 1
RED /

—2 2 1 24— LOGICAL IHPUTS
| [

GRH 31
—4 2 — vio | 1

| -5 1 ] — 2
BLU

6 2 t
— T LOGICAL OUTPUTS
— &

4 LOGICAL OUTPUTS
PHYSICAL OUTPUTS
Figure 93: 2x2 RGB Video Level
The maximum number of components in a configurasd® (16 for the 3500ProLE).

Column Descriptions:

e Name defines the name of the component. Componentesaane one to eight
characters in length and are constructed usingraage letters, numbers, and spaces.
The first character must be a letter. The exarsp®vn above is a 2x2 RGB video
level named VID, which is made up of three comptsm@amed RED, GRN and BLU.
For the example, "RED" would be used for the fi@inponent, "GRN" for the second,
and "BLU" for the third.

e Level Name specifies the name of the level associated vaghcomponent. You must
have already created the level you want to uséh@rtop half on this window) before
you enter the value in this field.
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Input Offset Acceptable values for input offsets are shown the General
Specifications Table. For the example shown ab®eand "0" would be used for the
component "RED"; "2" and "2" would be used for twnponent "GRN"; and "4" and
"4" would be used for the component "BLU".

Physical Input = Level Input + Component Input @ffs

3500Pro allows components to overlap in matrix spac Care should be
taken when entering offsets to ensure that any relfing overlap of
components is intentional.

- TIP:

If the Input value isthe same for several different offsets (for example, 0), type " 0"
in the first Input Offset field. Then, select the number you just entered, and
highlight the rest of the fields below it that have the same value. Click the right-
mouse button and select Fill-Down. All of the fields will populate with the same
I nput Offset value.

Output Offset Acceptable values for input offsets are showntlie General
Specifications Table. For the example shown ab®/eand "0" would be used for the
component "RED"; "2" and "2" would be used for tmmponent "GRN"; and "4" and
"4" would be used for the component "BLU".

Physical Output = Level Output + Component Outptis€

Type PRC, TGR (Tiger), XTN (External Manufacturer ohifd Party), or RM5
(System 5). Select the one you want from the ponisal menu.

Strobe Enter the Strobe assigned to the routing swittieg contains the component.

Every routing switcher in a switching system isigissd a strobe. This is usually
accomplished by setting a dipswitch on the badkefrouting switcher. Strobes do not
have to be unique and, in larger systems, eachestraght be associated with several
routing switchers.

In many switching systems, strobes are used topgietels of the same type together.
For example, video may be on Strobe 1, audio cob®tP, etc.

The following table shows the offset, strobe, addrass ranges for the RM5 and PRC
component types:

COMPONENT TYPES RM5 (SystEmM 5) | PRC, XTN, TGR

Offset Range 0-255 0-4094

Strobe Range 1-5 1-63
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7.11.2

RM5 components utilize the System 5 37 pin paratigrface. PRC, TGR, and XTN
matrices use the PRC RS-422 based interface. (PR®, and XTN matrices are all
controlled by the same set of commands. The diffee between the components is
the boundary size used for background checkingnatix health. PRC uses a 8x8
boundary, TGR uses a 48x16 boundary, and the XEN a$4x64 boundary.)

Working with Components

Adding a Component You can have a maximum of 32 components (16tfer
3500ProLE). To add a component, simply type nempmamnent information into a
blank row and then, select the necessary optiossithed above.

Deleting a ComponeniTo delete a component, click on the informatiau want to
remove and press the Delete key. You can deleteraeentries at one time by
highlighting all of the fields you want to deletben pressing the Delete key. When
you are done deleting a level, selédf. Be sure tave the configuration file.

CPU Link/Port

The Configuration > System Configuration > CPU Link/Port command allows you to

configure the serial ports on the 3500Pro Systemti©tber. This window (see Figure 94) is
divided into two sections. Refer to the followisgctions for information about the items in
each field of the window.

CPU Link/Port Configuration

CPU Link Protocol Configuration

Link Name

Link Type

Checksum

Terminator

Status Filter

PROTOCL1E

P1E

) aa)afa]a]a]a]n

PESA

o) aa]a]a]a]u

Requestor

CR-LF

o) aa]a]4]a]n

Lock Priority

Link Hame

Baud Rate

Stop Bits

1024
1025

0
0

PROTOCL1E 9600
PROTCL1E 9600

2
2

Figure 94:

CPU Link/Port Configuration Window
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7.11.2.1 CPU Link Protocol Configuration:

This section of the window allows you to define CBidk Protocol Configurations.
Then, you can assign a specific configuration foo& in the lower portion of the
window.

7.11.2.2

CPU Link Protocol Configuration

The Configuration > System Configuration > CPU Link/Port > CPU Link Protocol
Configuration section determines the format to be used when sgrutdita through the serial
ports on the 3500Pro System Controller. Then, geru assign a specific configuration to a
port in the lower portion of the window.

Link Name

This defines the name of the protocol configuratioat is being defined. It is used
when assigning a protocol variation to a serialt.po¥ou will associate a defined
configuration with a specific port in the lower pon of this window.

Link Type

This is the protocol, which determines the fornaalbé used when sending data through
the serial ports on the 3500Pro System Controll8elect one from the pull-down
menu. There are currently three protocols avaslédal use.

1. CPU Link Protocol 1 with Extensions (P1E) (8162@407-0)
2. Unsolicited Status Protocol (USP) (81-9062-08D9-

3. Truck Link Protocol (TRK) (81-9062-0410-0). Tkulink only works when
configured for COM4.

Checksum

A checksum determines how the validity of transeditiata will be confirmed. The
three available checksum types are:

1. NONE: No validity checking.

2. PESA: Data validity is checked using PESA's standaethod. (See Protocol
documentation.)

3. HEX ASCII: Data validity is checked using a standard HEXEAShecksum.
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e Terminator

The terminator is the character(s) to be used twtdgethe end of a data packet or
command string. The three terminators availalde ar

1.
2.

CR: A carriage return.
LF: Aline feed.

3. CL: A carriage return followed by a line feed.

e Status Filter

Status filtering allows the user to filter the daent through the port using USP. This
is only available for Unsolicited Status Protodd5f). The nine filters available are:

1.

© N o g bk w D

9.

A - All Unsolicited Items

C - Configuration Changes

D - Dual Transition Changes (Dual 3500Pro Contrdt&ms Only)
E - Confidence Errors

G - User Logon/Log Off

L - Lock/Protect Changes

P - Physical Switches

S - Switch Change Requests

U - User Account Changes

They can be specified in any combination. Enter filier you want to use in the
Status Filter field.

7.11.2.3 Port Configuration

The Configuration > System Configuration > CPU Link/Port > Port Configuration
section of the window defines the actual configoraof the three available ports. You can
assign specific CPU Link Protocol Configurationgirked in the top portion of this window
with each port (in theink Name field).

e Before Using This Command

You must have defined tH@PU Link Protocol Configurations in the top portion of
this window.
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e Address
This defines the port address. You can configuedallowing ports:

1. Port 1 - The default CPU link port, which is preatigured to be used with
3500Pro. The only items that may be changed enpbit are thé&ort Name
and theRequester Code.

Port 2 - Available for user configuration.

Port 3 - Not available. This port is the PRC Comiuations Port on the
3500Pro System Controller and may not be usedxtermeal control.

4. Port 4 - Available for user configuration.

. Port Name

Because a port is identified by its address, teeggament of a port name is optional. If
used, port names are one to eight characters gtheand are constructed using
uppercase letters, numbers, and spaces. TheHasacter must be a letter.

¢ Requestor

The requester code is used with the lock priordydetermine if a lock or protect

function can be removed. When a lock or protect been assigned by a port (or
panel), it can only be removed by another portp@nmel) with a higher lock priority or

with the same lock priority and same requester code

Requester codes not explicitly defined automatycdéfault to 1024, 1025, and 1027
for Ports 1, 2, and 4 respectively.

The acceptable range of requester codes is 1 56553
e Lock Priority

The lock priority is used with the requester codedetermine if a lock or protect
function can be removed. When a lock or protestlheen assigned by a port or panel,
it can only be removed by another port or panehwaitigher lock priority, or with the
same lock priority and same requester code. Therldle lock priority number, the
higher the priority.

Port lock priorities not explicitly defined autonwtlly default to "0" which gives
absolute authority to clear any lock or protect tbe system. The Lock Priority
assigned to Port 1, which may not be changed,"is "0

The acceptable range of lock priorities is 0-235 (5§ Highest Priority).
e Link Name

This defines the CPU Link Protocol Configuratioruywant to associate with this port.
Each configuration in the top portion of this windas identified by its Link Name.
Enter the Link Name you want to use from the togipo of the window in this field to
assign the correct configuration.
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e Baud Rate

Baud rate is the data transfer rate through thialsgort measured in Baud (bits per
second). A baud rate of either 9600 or 38400 negdected for Port 2 and Port 4.
Port 1's baud rate is specified by the dipswitchttoa controller board and cannot be
set via the configuration software. The baud isatEther 9600 or 38400 baud.

e Stop Bits

In asynchronous communications, a stop bit is #&hbit indicates that a byte of data has
just been transmitted. Every byte of data is ptedeby a start bit and followed by a
stop bit.

Either 1 or 2 stop bits may be selected for Paxh@ Port 4. The number of stop bits
assigned to Port 1, which may not be changed, is 2.

7.11.3 Configuration Info

The Configuration > System Configuration > Configuration Info window shows
information about the configuration currently oper8500Pro (see Figure 95).

Configuration Information

Configuration Parameters

Configuration Name: i'I'EST CONFIGURATION

Chop Rate:
Case Sensitivity: OFF

PRC Delay:

Configuration Statistics
Number Of Levels:
Number Of Components:
Number Of Sources:
Mumber Of Destinations:
Number Of Reentries:
Number Of Panels:
Number Of Salvo Groups:

Number Of Tielines:

Figure 95:  Configuration Information Window
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7.11.3.1

Configuration Name

This field allows you to name or rename the curpamtfiguration. Type the desired name in
the Configuration Name box. Configuration names may have up to 32 alphmamic
characters. You can query this name from the 3&08kstem Controller.

The Configuration Name may be different from the fle name.

7.11.3.2

7.11.3.3

7.11.3.4

Chop Rate

The chop rate indicates the frames rate of switclsesl by the Chop mode of operation. To
change the chop rate, enter the desired valuesiGhibp Rate box. The range of chop rates
the 3500Pro Control System can be configured foetsveen 1 and 255.

Case Sensitivity

This option specifies whether the 3500Pro softwdiséinguishes between upper and lower
case letters when you are entering informationhi@ tategory, source, destination, and
reentry windows. For example, if you have Caseskigity turned ON, the software will
recognize when you enter information using capittlers. If you have Case Sensitivity
turned off, it doesn’t matter if you use lower qper case.

After making changes, click th®K button to close the window. Be sure to save the
configuration file.

PRC Delay

This option specifies the delay between PRC messateapplies to PRC, TGR, and XTN
types of components. The range of the PRC delmevan be from 5 to 10 ms. The default
value is 10 ms.

7.11.4 Matrix Configuration

The Configuration > Matrix Configuration command allows you to define Sources and
Destinations. The maximum number of sources arstirdgions is 1200 (180 for the
3500ProLE).

There are 2 tab sheets in this window, one for ;sjrand the other for destinations. The
Destinations tab displays in yellow so you can Igadetermine which tab sheet you are
working with.
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7.11.4.1 Display Error Command

e When selected, entering invalid data in the sowrc®estination grid will display a
popup message box on the screen warning you ofntvadid data. You can not
continue until you click on th®K button to clear the message box. The invalid data
will be changed to a red color.

e When selected, entering invalid data in the sooragestination grid causes the invalid
box data to be displayed in red, but no messagewibke displayed.

7.11.4.2 Before Using This Command

You must have already used tBenfiguration > System Configuration > Level/Comp
command to set up all of the levels.

7.11.4.3 Sources

The Matrix Configuration > Sources tab allows you to define all of the sources in the
configuration (see Figure 96). Only one sourcelpeel is allowed. A level may be left
undefined on a source. Inputs may be shared betw#kerent sources. The maximum
number of sources is 1200 (180 for the 3500ProLE).

Router Matrix Configuration

M Display Error Message Box {Invalid data entries will always be shown in "Red”)

Sources

Name Src# | SDI | AES1 | AES2 | NTSC |ANALOG1 |ANALOGZ |ANAL063 |ANALOG=1

AECP1 107 107
AECP2 108 108
AUSWRPGM 111 111
AUX 22 109 109
AUX 23 109 109
AUX 24 109 109
AUX 25 109 109
AUX 26 109 109
AUX 27 109
AXSWRAX1

AXSWRAX2

AXSWRAX]

BARS 01

BLACK D1

CAM D1

CAM 02

CAM 03

CAM D4

CAM D5

CAM D6

CAM 07

CAM 08

Figure 96:  Matrix Configuration Sources Window
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e Name
Specifies the name of each source. Type in thesnjgm want to use in this field.
e Src # (Source Number)

Identifies the source number. As you enter Nantes field will automatically display
a number. The source number is a numeric aliaiscddua be used to refer top the
source. This is used by the serial protocols aocemental edits.

e Levels

The remaining columns identify the input on eachelethat you defined with the
Levels window. For each level, enter the sourcé tmaresponds with each Source
Name.

e Right Click in Source Grid

When you right-click in th&ource grid, a pop-up menu will appear, providing menu
options for some of the shortcut items mentioneskiction 7.1.2 of the manual as well
as a few other options. The other options may ay not be enabled, depending on
which column the cursor was in when the right-chieks performed. If you right-click
in the Name column, there will be a menu selection enableteddroperties (see
Figure 97).

Autoumber

Copy

Cuk

Paste

Copy Inctement
Insert

Expaort ko C5Y File

Fill-Up
Fill-Cimam
Fill-Left:
Fill-Right

Tigline Saurce Define

Properties

Figure 97:  Properties Enabled Source Grid)
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Clicking onProperties will display another screen that shows the destina that the
source that you right-clicked on idd8ked from (see Figure 98).

Properties for Source: CAM2

Source-Destination Blocks

Synt Heference Definijiupp————————————————

Level Sync Ref Sync Ref
1
2

® Apply Changes To All Destinations On Selected Level

Figure 98:  Properties —Source Destination Blocks

You can block more destinations or remove destingtirom theBlocked list. Notice
that theSync Reference Definition frame is disabledSync Reference Definition is
a destination property and is not available forses.
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If you right-click in one of the level columns, whiis any column to the right of the
Dst # column, there will be a menu selection enabletedaTlieline Source Define
(see Figure 99).

Auboumber

Copy

Zut

Paste

Copy Increrment
Insert

Export ko 3% File

Fill-Up
Fill-Down
Fill-Left
Fill-ight

Tieline Source Define
Propetties

Figure 99: Tieline Source Define

Clicking on Tieline Source Define will display another screen that enables the
definition of a source on a level connected byl (see Figure 100).

Tieline Source Definition for Source Group: LSM2B

Input #: m

T B CGAUD2 -

Level: CGAUD1

;

Figure 100: Tieline Definition Screen
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In the right-click menus shown previously, note thenu itemExport To CSV File.

If you click this item, a standard file save dialagl be displayed allowing you to
create a “*.csv” (comma separated variable) filgt ttontains the source configuration
data shown in th8ources grid. This *.csv file can be loaded directly irEacel” and

a host of other programs. The file contains a beaalv followed by the configuration
data. Once loaded into Ex@el the data can be formatted to your
specifications/requirements and printouts can tieeperformed.

7.11.4.4 Destinations

The Matrix Configuration > Destinations tab (see Figure 101) allows you to define all of
the destinations in the configuration. The maxinmumber of destinations is 1200 (180 for
the 3500ProLE).

Router Matrix Configuration

o Display Error Message Box (Invalid data entries will always be shown in “Red”)

Name | AES1 | AES2 | NTSC |ANALOG1 |ANALOGZ |ANALOGH |ANAL064

ADMON 65
AUD ECP1 35 107 35 107 35 35
AUD ECP2 36 108 36 108 36 36
AUD1

AlD2

AlUDQC

AUXSWR 1

AUXSWR 2

AUXSWRO3

AUXSWRI4

AUXSWROS

AUXSWROG

AUXSWRO7

AUXSWRIB

AUXSWR2

AUXSWR3

AUXSWR4

CAMRT 1

CAM RT 2

ooy |

ccz

cGm

Figure 101: Matrix Configuration Destinations Window
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e Name

This specifies the name of each destination. Tggle name you want to use in this
field.

o Dst # (Destination Number)

This identifies the destination number. As you endames, this field will
automatically display a number. The destinatiomper is a numeric alias that can be
used to refer top the destination. This is usedhieyserial protocols and incremental
edits.

e Levels

The remaining columns identify the input on eachelethat you defined with the
Levels window. For each level, enter the destimatiat corresponds with each Source
Name.

e Right-Click in Destinations Grid

When you right-click in théestinations grid, a pop-up menu will appear, providing
menu options for some of the shortcut items meetioin section 7.1.2 of this manual
as well as a few other options. The other optiorsy or may not be enabled,
depending on which column the cursor was in wherright-click was performed. If
you right-click in theName column, there will be a menu selection enabledkdal
Properties (see Figure 102).

Autatumber

Copy

Zuk

Paske

Copy Increment:
Inserk

Export bo 5% File

FEll-Lp
Fill-Dar
Fill-Left
Fill-Right

Tieline Source Define
Properties

Figure 102: Properties Destinations Grid)
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Clicking on Properties will display another screen (see Figure 103) gtaws the
sources that arBlocked from the destination that you right-clicked onvesl| as the
Sync Reference Definition for this particular destination. By checking tdteeckbox

at the bottom of th&ync Reference Definition frame, any change you make to the
Sync Reference Definition for a level, will be applied to every destinatitiat is
defined on that level.

Properties for Destination: DD35-29

Source-Destination Blocks

Sync Ref Sync Ref
SYNC1

# Apply Changes To All Destinations On Selected Level

Figure 103: Properties For Destinations Display

In the right-click menus shown previously, note thenu itemExport To CSV File.

If you click this item, a standard file save dialagl be displayed allowing you to
create a “*.csv” (comma separated variable) filattitontains the destination
configuration data shown in thHestinations grid. This file can be loaded directly
into Excef’ and a host of other programs. The file contaiheader row followed by
the configuration data. Once loaded into EXcéhe data can be formatted to your
specifications/requirements and printouts can tieeperformed.
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7.115 Pands

TheConfiguration > Panels command adds new panels to the configurationthétop of the
window, a graphic illustration of the selected gatdisplays. Below the graphic, there is a list
of all the currently defined panels.

The description field is the only field that can Oeectly changed. The description is a
completely optional field that does not have afi@ctthe configuration of the controller. It is
strictly a convenience field for the user to healpritify the control panels. The information is
stored in the controller so that it will be recdllater when the configuration is uploaded. The
address, name, and type fields cannot be diretidywged. These fields are populated when
you create a new control panel as described ifoll@ving subsections.

The following tabs display in this window:
o Panel Specific Data

Data Key Definition

Panel Access Lists

List Assignment

Salvo Key Definition

7.11.5.1 Before Using This Command
e You must have already set up Levels and Components.
e You must have already set up the Matrix Configorati
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7.11.5.2 Adding a New Panel

1. Choose th&pecific panel tab
Select th&lew Panel button.
Select the panel from tAgpe list.
Enter theRequestor Code.
Enter thdock priority
Enter thestatus method.

I

7.11.5.3 Panel Specific Data

The Panel Specific Data tab (see Figure 104) allows you to add new pareli, existing
panels, and delete panels. This tab also allowstgadefine information about the panel,
such as name, address, etc. The following fieldsagailable in this panel:

Control Panel Configuration

wh [:Il:l I DI:II:LEIEIEIDEIEIEI O DLJ=

Description

Panel Specific Data Data Key Definition [Panel Access Lists List Assignment Salvo Key Definition

Type RCP 64X |+ Data Key List
Address _ Requestor Code _ Level List
Lock Priority _ Status Method m Src Include List

Dst Include List
Name D 1

Status Level [T - Slv Include List
Default Dest. m Salvo Key List

;

Figure 104: Panel Configuration Window, Panel Spetic Data Tab
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If you right-click in the configured panels gridhigh is right below the panel image, a pop-
up menu (see Figure 105) will be displayed. If ytiok the item labeled&Export To CSV
File, a standard file save dialog will be displayeadwlhg you to create a “*.csv” (comma
separated variable) file that contains the cormgasiel configuration data shown in tRanel
Specific Data tab of the panel screen. The file can be loadrttty into Excef and a host
of other programs. The file contains a header falewed by the configuration data. Once
loaded into Excél, the data can be formatted to your specificatregsirements and
printouts can then be performed.

0

Copy

Paste

Export ko C5Y File

Fill-Erar

Imsert Rows
Delete Rows

Soft: Key Definition

Properties

Figure 105: Exporting To CSV File Menu

Type

This field identifies the type of panel. This fiés read-only unless you select thew
Panel button. The panel you select here displays imtidelle section of the window
in theType field.

Address

This indicates the physical address of the conpaotel. Every control panel has
dipswitches on the back. These switches are usestta unique address for each
panel in a switching system. Find out what theresil is, and enter it here. The
address you enter here displays in the middle @edaf the window in thé\ddress
field.

Requestor Code

The requester code is used with the lock priordydetermine if a lock or protect
function can be removed. When a lock or protest been assigned by a panel (or
serial communications port), it can only be remobgdanother panel (or port) with a
higher lock priority or with the same lock priorizyd same requester code.

Requestor codes are also used with protects. \Whisstination is placed into protect,
only those panels/users with the same request@ar caa switch the destination.

Requester codes not explicitly defined automatcadifault to the panel address.

Proprietary Information of PESA SWITCHING SYSTEMS, INC. 105



§§ PESA 3500PRO/LE — SECTION 111

81-9059-0549-0 Rev. E

Lock Priority

The lock priority is used with the requester canldétermine if a lock or protect can be
removed. When a lock or protect has been assigpedpanel or port, it can only be
removed by another panel or port with a higher Ipdbrity, or with the same lock

priority and same requester code. The lower tok friority number, the higher the
priority.

Panel lock priorities not explicitly defined autamsally default to "0" which gives
absolute authority to clear any lock or protecttlom system. The acceptable range of
lock priorities is shown in the General Specifioat Table.

Status Method

When a panel is in all levels mode (ALL LEVS), #tatus shown will be the source on
the Status Level assigned to that panel. If trstiition is not defined on the Status
Level, Status Method is used to control the resulting display:

If DEF (Default Method) is selected, NO XXXXX will be gitayed where XXXXX is
the Status Level assigned to the panel.

If GRP (Group Method) is selected, the controller will exae every level
sequentially, starting with the level designated.egel Order 1. The source switched
on the first level found where the destination &firted, will be displayed as the
destination status.

Name

Because a panel is identified by its address, $eament of a panel name is optional.
If used, panel names are one to eight charactelsngth and are constructed using
uppercase letters, numbers, and spaces. Thelimsacter must be a letter. The name
you enter here will display in the middle portiohtlbe window as the "Name" of the
panel.

Status Level

One function of the LCD display on a panel is t@whwhich source is currently
switched to a selected destination. This is knawmlestination status. Although more
than one source can be switched to a single déstinflimited to one source per
level), the status display can only show one soatcetime. When the panel is in all
levels modeALL LEVS), Status Level is used to designate a default level to be used
when displaying status. Only the source on thifawde level will be displayed.
Pushbutton only panels also use the status leNdk used to determine which tally
LED to light on a panel in a split/breakaway coratit
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o Default Dest

Select the default destination for which status el displayed when power is applied
to a panel, or when a new configuration is downéahth the controller.

The panel will have control over the destinatiolested here, even if it is not included
in the associated destination include list.

e Data Key List
A data key is a user configurable control panel, kelyose assigned function is used
when the panel is in any mode exc8ptvo Select Mode.

A data key list is a named list of the functionsigsed to each data key on a panel. A
data key list may be shared by multiple panelsoag las they are the same type of
panel. Different panel types may not use the sdae key list.

Define newData Key Lists with theData Key Definition tab.

e Level List

TheLevels of Control List is a named list of all levels the panel (emote client) is
authorized to control. Two special lists come poefgured: ALL andNONE. Define
new items that should appear in this list with Bremel Access Lists tab (in the Include
List Type section, select Level).

e Src Include List

A source include list is a named list of the sosraespecific control panel is authorized
to control. A source include list may be sharedriftiple panels.

The Source Include List is a named list of all sources the panel is aigbkdrto
control. It functions the same as thEVELS OF CONTROL LIST window. Define
new items that should appear in this list with fhenel Access Lists tab (in the
IncludeList Type section, seleckource).

e Dst Include List

A destination include list is a named list of thestiations a specific control panel is
authorized to control. A destination include hsay be shared by multiple panels. The
default destination assigned to a panel may beralted even if it is not on the
destination include list. Define new items thabdld appear in this list with thieanel
Access Lists tab (in the Includé&ist Type section, seledDestination).

e Slv Include List

A salvo include list is a named list of the sal@ospecific control panel is authorized to
control. A salvo include list may be shared by tiplg¢ panels. Define new items that
should appear in this list with tH@anel Access Lists tab (in the Include.ist Type
section, selecalvo).
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Salvo Key List

A salvo key is a user configurable control panel, kehose assigned function is used
when the panel is in salvo select mode. A salwoliseis a named list of the functions
assigned to each salvo key on a panel. A salvolikeynay be shared by multiple
panels as long as they are the same type of pddéflerent panel types may not use
the same salvo key list. Define new items thatikhappear in this list with th®alvo
Key Definition window.

New Panel

The New Panel button adds a new panel to the list in the ceotehe screen. You
need to select the Type of panel to add, and defirad the other information about the
panel (on all five tab sheets).

Copy Panel

Copies all of the information about the currendjested panel and creates a new panel
with identical information. The new panel will amatically display in the list in the
middle of the window with a new panel address. Yoam then enter a name and
description for the new panel.

Delete Panel
This deletes the currently selected panel.

Make sure you really want to delete the panel befer selecting this
command. You cannot "Undo" this action.
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7.11.5.4 Data Key Definition

The Data Key Definition tab (see Figure 106) sheet defines the settingseéfxh
configurable control panel key, whose assignedtfands used when the panel is in any
mode excepSalvo Select Mode. At the top of the window, a picture of the cuntig
selected panel displays. Click on the buttonshencbntrol panel to see the Data Key that is
assigned to the button. You can change which pamehlre reviewing by selecting another
panel from the middle part of the window (with Adds, Name, and Type listed). Also, the
List Names that are defined in this tab sheet are the itdrasdisplay in th®ata Key List

in thePanel Specific Data tab.

Control Panel Configuration

Description

Data Key Definition

Panel Access Lists List Assignment Salvo Key Definition

Name/Cat
BLACK
CAM 1
CAM 2
CAM 3
CAM 4
CAM S Levels Cats
CAM 6 VIDEOQ APRISA
CAM 7 AUDIO 1 AUDIO
CAM 8 AUDIO 2 AUDSUB
CAM 9 AUDIO 3 AUX

] DAH

Figure 106: Data Key Definition Tab
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If you right-click in the data key list grid, loet on theData Key Definitions tab of the
panel screen, a pop-up menu will be displayed Ksgare 107). If you click the item labeled
Export To CSV File, a standard file save dialog will be displayedwihg you to create a
“*.csv” (comma separated variable) file that consathe data key definitions for all data key
lists in the controller configuration. This filae be loaded directly into Exfeand a host of
other programs. The file contains a header rovoviedd by the key list data. Each key list in
the CSV file is separated by a blank row and costéhe list name, panel type, and the key
definition data. Once loaded into Extelthe data can be formatted to your
specifications/requirements and printouts can tieeperformed.

ik

Copy

Paste

Export bo CSY File

Fill-Dawn

Inserk Rows
Celete Rows

Sofk Key Definition

Properties

Figure 107: Data Key List Grid Menu

o Definition List

This identifies th&Key Type andName/Category associated with a specific button on
the panel. When you select an item from this tis¢, graphic at the top of the screen
will highlight the button you selected. To charige definition, double-click items in
theSources, Destinations, Levels, or Categories lists.

e Sources

This lists all of the available sources for the gdlanDouble-click any item in this field
to assign it to the currently selected key. Yom akso copy and paste.

o Destinations

This lists all of the available destinations foe thanel. Double-click any item in this
field to assign it to the currently selected key.

e Levels

This lists all of the available levels. Doubleegliany item in this field to assign it to
the currently selected key.
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Categories

This lists all of the available categories. Doutliek any item in this field to assign it
to the currently selected key.

Soft Sources/Soft Destinations

Typing SSRC or SDST sets the data key type to a soft key. A soft kap be
programmed by the user at a panel.

List Name

This shows the existinBata Keys. These items display in tH2ata Key List pull-
down in thePanel Specific Data tab. When you select tiidew DK List button, a
new line displays in this section. You can doutllek any name in this list, and type
in a new name.

New DK List
Adds a nevData Key List to theList Name field. Type in the name for the new list.
Copy DK List

Copies the information in the currently seledbata Key List and creates a neata
Key List with identical information. The neWata Key List will display in theList
Name field and you can specify a new name for the list.

Del DK List
This deletes thBata Key List that is selected in tHast Name field.

Make sure you really want to delete the list beforeselecting this command.
You cannot "Undo" this action.
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7.11.5.5 Soft Key Definition
Soft Keys can be configured locally at the paneigiStore Mode, or with 3500Pro.

Soft Keys cannot be configured until at least oneo& key has been defined
in the Data Key List assigned to the panel.

7.11.5.6 Panel Access Lists

The Panel Access Lists tab (see Figure 108) shows the include lists fevdls, Sources,
Destinations, and Salvos. Included lists are nalisesiof the Levels, Sources, Destinations,
and Salvos a specific control panel is authorizeddntrol. A source include list may be
shared by multiple panels.

Control Panel Configuration

Address Description
1

Panel Access Lists

List Assignment Salvo Key Definition

Panel Specific Data | Data Key Definition

Include List Type —, Include List Contents
o Level List Name
AUDIO Levels Include List =

#® Source QUAD AUDIO 1
® Dest. STERED AUDIO 2

# Salvo VID KEY AUDIO 3
AUDIO 4

Associated Panels
TD 4 4

Figure 108: Panel Access List Tab
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Include List Type

Lists the types of include lists you can reviewedit. Click on the button to the left of
the list.

List Name

Lists the names of the lists associated with estlype. Click on each item in this list
to review its contents.

If you right-click in theList Name grid, located on thPanel Access Lists tab of the
panel screen, a pop-up menu will be displayed sgere 109). If you click the item
labeledExport To CSV File, a standard file save dialog will be displayedwalhg
you to create a “*.csv’(comma separated variable) that contains the include list
definitions for all include lists in the controlleonfiguration. This is file can be loaded
directly into Excel and a host of other programs. The file contairtseader row,
followed by the include list data. Each includg in the CSV file is separated by a
blank row and contains the list name, list typed #me definition data depending on
whether it is ad_evel, Source, Destination, or Salvo include list. Once loaded into
Excel, the data can be formatted to your specificati@asfirements and printouts can
then be performed.

ik

opy

Paste

Export Eo C5Y File

Fill-Cratair

Insert Rows
Delete Rows

Soft Key Definition

Properties

Figure 109: List Name Popup

Associated Panels

Shows the panels associated with each list yowtseletheList Name field. To
associate a list with a panel, go to tenel Specific Data tab. Select an item from
the Level List, Src Include List, Dst Include List, or Slv Include List. After you
select a list to associate with the panel, the lpaa@e and number will display in this
field.
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New Inc. List

Create a new Include list in thést Name field. Be sure to first select the type of list
you want to create in thaclude List Type field. After you select this button, type a
name for the new list.

Copy Inc. List

Copies theLevel andInclude List settings for the selectddst Name and creates a
new item in theList Name field. You can then enter a different name fa tiew list
item.

Del Inc. List
This deletes the selected list from thset Name field.

Make sure you really want to delete the list beforeselecting this command.
You cannot "Undo" this action.

Include List Contents
Levels/Sources/Destinations/Salvos

The title and contents of this section will chamgpending on the item you select in
thelnclude List Type field are as follows:

1. Level: This section will show all of the available level

2. Source: This section will show all of the available soesc
3. Dest: This section will show all of the available destiions.
4. Salvo: This section will show all of the available sadvo

Include List

Shows all of the items in the include list. To additem to the include list, select it
from the left portion of the window, then selece tf> button. The items will move
from the left column to the right column.
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7.11.5.7 List Assignment

The List Assignment tab (see Figure 110) shows all of the panel list&d are currently
defined, the panels that are actually available, e panels that are associated with each
different list.

Control Panel Configuration

Address Description
1

Panel Specific Data [Data Key Definition [Panel Access Lists List Assignment Salvo Key Definition

Panel List—— m Panel SelectionList——MMMMMMM
o Data Keys SINGLE Awvailable Panels Associated Panels

TD TD 1 1 DIR
® Level Include TD 2 P1L

TD 3 OFFICE
® Source Include TD 4 P3 R

2
3
4
TD 5 5 P3L
7
9

& Dest. Include PROD AUD 1
PANEL 9 ALD 2

® Salvo Include ALD 3
ALD 4

® Salvo Keys vTQC

Figure 110: List Assignment Tab
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e Panel List

This section lists each of the different types ahg lists. Select each button to review
the lists available.

e List Name

Shows the lists available for the type of panglyisu select in th€anel List section.
Select each individual list to review the panelattare currently available and the
panels that are currently associated with the list.

e Available Panels

This section shows all of the panels that are atigrevailable to associate with the
selectedList Name. To associate an available panel with the sedelisé select the
panel then select the> button. The panel will move from thevailable Panels to
Associated Panels column.

e Associated Panels

Shows the panels actually associated with the teeléést Name. To disassociate a
panel from the list, select the panel name theecseéhe<< button. The panel will
move from theAssociated Panels column to theéAvailable Panels column.
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7.11.5.8 Salvo Key Definition

A salvo key (see Figure 111) is a user configuraidatrol panel key, whose assigned
function is used when the panel is in salvo seatente.

A salvo key list is a named list of the functiorssigned to each salvo key on a panel. A
salvo key list may be shared by multiple paneléoag as they are the same type of panel.
Different panel types may not use the same salydi&e

Control Panel Configuration

Description

Panel Specific Data Data Key Definition Panel Access Lists

- Salvo Group

Figure 111: Salvo Key Definition Tab

A Salvo Key List cannot be created until at least me salvo has been
configured.
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If you right-click in theSalvo Key List grid, located on th8alvo Key Definitions tab of the
panel screen, a pop-up menu will be displayed Fsgare 112). If you click the item labeled
Export To CSV File, a standard file save dialog will be displayedwlhg you to create a
“*.csv” (comma separated variable) file that consathe data key definitions for all data key
lists in the controller configuration. This filae be loaded directly into Exfeand a host of
other programs. The file contains a header rolig@d by the key list data. Each key list
in the CSV file is separated by a blank row anda@os the list name, panel type, and the key
definition data. Once loaded into Extelthe data can be formatted to your
specifications/requirements and printouts can tieeperformed.

_ut

Copy
Paste

Export ko C3Y File

Fill-Drown

Insert Rows
Delete Rows

Saft Key: Definitian

Properties

Figure 112: Salvo Key List Grid Menu

Salvo Group

This field shows the salvo group associated wittheadividual button on the panel.
You can click on the button on the panel at thediofne window to see that salvo group
associated with it, or, you can select the rowighlight the associated panel button.

e List Name

This shows the names of the defined salvo listsis Window shows the salvo groups
associated with the list.

e Salvo Grps

TheSalvo Grps shows the currently defined Salvos (using@oafiguration > Salvo
command).

e New SK List

This adds a newalvo list to theList Name field. Type in a new name for the lists,
then select the salvos to associate with it froeS&lvo Grps field.
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e Copy SK List

Copies the information in the currently selecBadvo List and creates a new List with
identical information. You can then change the eaithe newsalvo List.

e Delete SK List
This deletes the selectedst Name.

Make sure you really want to delete the list beforeselecting this command.,
You cannot "Undo" this action.
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7.11.6 Salvo

The Configuration > Salvo command allows you to add, edit, and delete Salses Figure
113). A Salvo is a group of predefined logicaltsives taken at the same time. All switches in
a Salvo are taken within the same vertical intervitie maximum number of Salvos is 128 (64
for the 3500ProLE). The maximum number of Salvtries is 1024 that is spread across the
128 (64) Salvo Groups.

Salvo Configuration

Salvo Groups

Name Number = = 8w Fill All Levels

Fill Levels

Salvo Entries

ANALOG 1 |ANALOGZ |ANALOG3I |ANAL(=

Figure 113: Salvo Configuration Screen

7.11.6.1 Before Using This Command

e You must have already set up Levels and Componvite the Configuration >
System Configuration Level/Comp command).

e You must have already set up Sources and Destigafwith theConfiguration >
Matrix Configuration command).

7.11.6.2 Adding a New Salvo:
1. SelecConfiguration > Salvo to open the&alvo Configuration window.

2. In theSalvo Groups section, enter a name for the salvo. The numieé Will be
automatically populated.

3. Make sure you do not highlight another row ia 8alvo Groups field, then click in
theDestination field in the top row of th&alvo Entries section.
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Scroll through thdestinations list at the top of the window. When you find the
destination that you want to assign to the Saleobte-click it. The destination name
displays in th&Salvo Entries list.

Follow the same procedures for the sourcesthérbalvo Entries section, highlight
the source field that you want to define. Scrblough theSources list and then,
double-click the source you want to use.

If you want to fill in several levels all at onogu can clickFill All Levels. This will
assign one source to all levels, or, you can se$peicific levels you want to
automatically populate by select items from Fik Level section. Each level that is
highlighted will be automatically assigned a soufz you double-click.

After completing one salvo, you can go back to$haé/o Groups section, click on the
second row, and repeat this process.

When you are finished entering salvos, cli2K to save your changes and to close the
window.

7.11.6.3 Editing a Salvo

1.
2.
3.

SelectConfiguration > Salvo to open th&alvo Configuration window.
In theSalvo Groups section, select the salvo you want to edit.

Change any of the destination and source infoomafollowing the procedures
outlined for adding a new salvo.

When you are finished editing one salvo, you eafect another from th8alvo
Groups list, and edit it.

When you are finished editing, select @i¢ button to save your changes and close the
window.

7.11.6.4 Deleting a Salvo

1.

2
3.
4

SelectConfiguration > Salvo to open th&alvo Configuration window.
In theSalvo Groups section, select the Name of the salvo you wadetete.
Select th®elete button, and the salvo will be deleted.

When you are finished deleting one salvo, yoo salect another from the Salvo
Groups list, and delete it.

When you are finished, select t¥K button to save your changes and close the
window.
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7.11.7

Categories

The Configuration > Category option defines categories (see Figure 114). Agaly is an
optional entity assigned to a panel key that mayused alone, or with other categories, to
select a source, destination, or reentry. Categpifi used, are simply sub strings used to build
names (source, destination, and reentry) by linkiggether. When the user presses a category
button on a panel, the category is linked ontorigat side of the name in the preset. |If
necessary, the left side of the name will be trimirfebring its length to a maximum of eight

characters.

Category Configuration

Cateyories
AUDIO

AUDSUB
AUX
BARS
BHS
BLACK
BLUE
BLUEIN
Bac
BUZLZS
CAM
CAMZ
CAM3
DISK
DSKPYVW
DSS

Figure 114: Category Configuration Window
Functionally, categories only affect panel operaiovhere panels have been defined to have
categories assigned to their data keys.
Panels can have one or two categories assigneddtakey. When the user presses a category
button, the panel concatenates the category tedimee or destination name on the panel.

When two categories are assigned to a button, dhelpses the first category if the preset is
blank. Otherwise, the panel concatenates the sematedory. This requires the user to use the
CLEAR button to clear out the preset name beforessing the first category assigned to a

key.
When there is only one category assigned to a muitas always linked to the name in the
preset.
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For example, given a panel with the following diéfoms:

Button 1 Button 2 Button 3 Button 4 Button 5
Catl: VTR Catl: CAM Catl: CG Catl: 3 Catl: 4
Cat2: 0 Cat2: 1 Cat2: 2 Cat2: Cat2:

To access VTR13 and take it online, the user wpuds:
1. CLEAR (Clears out the name in the preset display)
2. Button 1 ¥TR in the preset display)
3. Button 2 ¥ TR1 in the preset display)
4. Button 4 Y TR13 in the preset display)
5. TAKE (Caused/TR13 to be taken to the active destination.)

You can assign up to 254 categories. To entertegeogy, click in the field and type the
category name. A category can contain any comiomatf leading, trailing, embedded spaces,
or simply be a space. When representing a leaafiricpiling space, the space character must
be substituted with the “~” (tilde) character. &gm in the middle of a category must be
represented with the space character. A “~” thambedded within a category will cause an
error.
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7.11.8 Tielines

The Configuration > Tielines command defines tielines, which are special typekgical
switches that allow a logical input on one levebtswitched to a logical output on a different
level (see Figure 115).

Tieline Configuration

Tieline Name: T2
Output Level: M Input Level: LU b -

Qutput #:

Input #: m

Figure 115: Tieline Configuration Window
Tielines are not available with the 3500ProLE.
The maximum number of tielines is 64.
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The example shown (see Figure 116) demonstratediretbeing used to route a video signal
from an analog camera, through an external anaaligital converter, to a digital VTR.

ANCAM
LOGICAL
INPUTS
12345678 ANALOG TO DIGITAL CONVERTER
R IR LEVEL ANAVID
I — 1
—® |, LOGICAL
d INPUTS
3
12345678
4 [ N N A A
| - 1
— 1 LOGICAL
° THNEL L > OUTPUTS
7
8 — 3
— 8 LOGICAL B
OUTPUTS , ® 4 —{DIGVTR |
ROUTING SWITCHER % | -
— 6
LEVEL DIGVID _ O
g

ROUTING SWITCHER

Figure 116: Tieline Example
Once a Tieline has been configured, it may then hesed by a source.

7.11.8.1 Adding a Tieline
To add a tieline, follow these steps.

1. Click in a blank field at the bottom of the screffryou do not select a blank field, an
existing tieline will be overwritten. A blank rowilivhighlight.

At the top of the window, enter a name in the TielName field.

Select the Output Level and Output # for the telilhe output cannot be used by any
other tieline or destination.

Next, select the Input Level and Input # for tleditie.
Select Add/Edit Tieline. The tieline displays iretlist at the bottom of the window.
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7.11.8.2 Editing a Tieline
To edit a tieline, follow these steps.
1. Select the tieline you want to edit.
2. Enter the new information in the upper portiéthe window.

After you are done editing information, select tAdd/Edit Tieline button. The new
information will display in the tieline.

7.11.8.3 Deleting a Tieline
To delete a tieline, follow these steps.
1. Select the tieline you want to delete.

2. When the row highlights, select tbelete Tieline button. The tieline will be removed
from the list.

7.11.9 Reentry

The Configuration > Reentry command adds reentries and entities, which exsbath a
source and destination at the same time (see FibLr¢ The function of reentries is to
facilitate switching a single source to multiplestieations with a single, logical switch.

Reentry Configuration

Source #

Figure 117: Reentry Configuration Window
Reentries are not available with the 3500ProLE.
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Example (see Figure 118): assume there existss@RC1 and destinations DST1, DST2, and
DST3. Reentry REENT1 is created and switched ®thinee destinations. With a single
logical switch, SRC1 can now be switched to REENIhd the signal will arrive at all three
destinations at the same time.

DST1

SRC1 REENT1 DST2

DST3

Figure 118: Reentry Example

The maximum number of reentries is 8.

7.11.9.1 Adding a Reentry

1.
2.
3.

SelecConfiguration > Reentry to open thé&rkeentry Configuration window.
In theName field, type the name of the Reentry.

In theSource # field, type the source number. When a reentryengcreated, an
unused source number is automatically assigneldet@adurce number field. You may
use this number or change it to some other unusedes number.

In theDest # field, type the destination number. When a rgenrme is created, an
unused destination number is automatically assigoettie destination number field.
You may use this number or change it to some athesed destination number.

SelecOK to close the window.

7.11.9.2 Editing a Reentry

1.
2.
3.

SelecConfiguration > Reentry to open thé&keentry Configuration window.
Change any of the information in the window.
SelecOK to close the window.

7.11.9.3 Deleting a Reentry

1.

2
3.
4

SelecConfiguration > Reentry to open thé&keentry Configuration window.
Highlight name of the Reentry you want to delete

Press th®elete button. The reentry is deleted.

SelecOK to close the window.
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7.11.10 Remote Client

The Configuration > Remote Clients command allows you to add, edit, and remove remote
clients from the 3500Pro system (see Figure 119)is window defines the part of the matrix

that remote clients can see and control. The Kkl software uses remote clients to

provide names, passwords and privileges for itssuse

Remote Client Configuration

Level Incl. SRC Incl.

DST Incl.

SLV Incl.

ALL ALL

ALL

AL |

AUD SETH
NTSC
NTSCAY
SDI
VIDEO

User Name

SETH
VTQC

Password Lev Include

Src Include Dst Include Slv Include

Options

Figure 119: Remote Client Configuration

7.11.10.1 Before Using This Command
Remote clients must have the KlikControl software.
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7.11.10.2 Adding a New Remote Client

1.

9.

SelectConfiguration > Remote Client to open theRemote Client Configuration
window.

In theUser Name field, type in the user’s name.

In thePassword field, type in a password for the user. As youetype password, it
will display in the field. As you select the neidld, however, the password will be
encrypted and you will no longer be able to tellaivthe password is. Be sure the
remote user knows his/her user name and password.

Select thé.ev Include field for the user and then, from thevel Incl. field, select the
Level List, which defines the levels that you want the useadcess. If they should
have access to all levels, selatdt The options that display in thevel Incl. field are
defined in theConfiguration > Panels window in thePanel Access List tab as
Level Include Lists.

Select thé&rc Include field for the user. In th8rc Incl box at the top of the window,
select theSource Include List, which defines the sources that the user shoulabbe
to access. If they should have access to all ssuselecAll. The options that display
in the Level Incl. field are defined in th€onfiguration > Panels window in the
Panel Access List tab asSource Include Lists.

Select th®st Include field for the user. In thBst Incl box at the top of the window,
select theDestination Include List, which defines the destinations the user should be
able to access. If they should have access tdeatinations, seledll. The options
that display in thé&evel Incl. field are defined in th€onfiguration > Panels window

in thePanel Access List tab afDestination Include Lists.

Select th&lv Include field for the user. In th8lv Incl box at the top of the window,
select theSalvo Include List that defines the salvo groups the user shouldobeta
access. If the should have access to all salvapgroseleciAll. The options that
display in theSlv Incl box at the top of the window are defined in @@nfiguration >
Panels menu item on thBanel Access Lists tab asSalvo Include Lists.

The Options field provides a place to enter additional infotima about the user. You
can enter a text string here.

Now you can add additional users if necessary.

10. When you are finished, sel€XK to save your changes and to close the window.
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7.11.10.3 Editing a Remote Client

1.

SelectConfiguration > Remote Client to open theRemote Client Configuration
window.

In the lower part of the window, select the ugan want to edit. The user name field
highlights.

Make changes to any of the information for teeru

When you are finished, you can add, edit, dedéter users, or sele@K to save your
changes and close the window.

7.11.10.4 Deleting a Remote Client

1.

3.

SelectConfiguration > Remote Client to open theRemote Client Configuration
window.

In the lower part of the window, select the ugar want to delete. The user name field
highlights.

SelecDelete, then pres&nter. The user will be deleted.

You can now add, edit, or delete additional usersselectOK to save your changes and
close the window.
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7.12

7.12.1

7.12.2

7.12.3

7.12.4

7.12.5

7.12.6

WINDOW MENU

The Window menus arrange the windows that display in the 36®@Rerface. The following
commands are available:

e New Window
e Cascade
e Tile Horizontal

e Tile Vertical

Arrange Icons

New Window

The Window > New Window command opens a second window that displays thee sa
information as the currently active window.

Cascade

The Window > Cascade command arranges all of the open windows so they slightly
overlap one another.

Tile Horizontal

The Window > Tile Horizontal command arranges all of the open windows so that all
appear on the screen in a horizontal row.

Tile Vertical

TheWindow > Tile Vertical command arranges all of the open windows so tieat all appear
on the screen in a vertical row.

Arrange lcons

TheWindow > Arrange Icons command aligns the icons of collapsed window mw along
the bottom of the screen.

Open Windows

The currently open windows are listed at the botwimhe Window menu. The currently
active menu has a check mark next to it. To gyigklitch to another open window, select
another window from this list, and it will becometiae and display.
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7.13 HELP MENU

The Help menu displays the 3500Pro help file and the ctrvension number of the 3500Pro
software. The following commands are available:

e Contents
e Search for Help On
e About

7.13.1 Contents

The Help > Contents option opens the contents tab of the help fileonkthere, you can
browse for the topic you want to review.

7.13.2 Search for Help On

TheHelp > Search for Help On option opens the Index tab of the help fil€ype in a word
you need help on, and matching items will highlighthe window. Double-click an item to
open the help topic.

You can also use the Find tab to search on any worid the help file. Try
this option if the topic you are looking for is notlisted in the index.

7.13.3 About

The Help > About option displays the version of the 3500Pro sofewatn addition, if you
select the System Info button, detailed informatadout your computer hardware and software
displays. This information is useful to reviewdu need to call Technical Support.
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Chapter 8 - 3500Pro Status and

Diagnostics

The 3500Pro Status module shows the status ofreliffeparts of the 3500Pro system. The

following menu items are available:
e File Menu
e View Menu

e Tools Menu

e Status

e Preset

e Tielines

e Panel

e Readback

e Window Menu

e Help Menu

8.1 FILE MENU

The File menu logs you into the 3500Pro Status module,eslagpen windows, and exits the

module. The following commands are available (Sgere 120):

| File

Lagin

Close Ckrl+F
Exit alt-F4

Figure 120: File Menu

811 Login
TheFile > Login menu logs you into th8tatus module.

e Before using this commangou must have a User name and password. Ref&0@P30

User Manager for information on creating and editisers.
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812 Close
TheFile > Close command closes the currently active window.

e Before using this commandyake sure the window you want to close is actie (op
border is highlighted).

8.1.3 Exit
TheFile > Exit command closes the 3500Pro Status window.

8.2 VIEW MENU

8.2.1 View Menu

The View menu displays and hides the toolbar and status @&at open different status
windows. The following commands are available (Segire 121):

v ToolBar
v Shtatus

Matrix Skakus. ..
Preset...
Salvo..,
Reentry. ..
Source Skatus, .,
Tieline. ..

Matrix Confidence. .,
Panel Status, .,
Readback Status. ..
Memory Sbatus, .,

Figure 121: View Menu

8.2.2 Toolbar

The View > Toolbar command hides or displays the bar with the shoitmns. Select this
command to display or hide the toolbar.

8.2.3 Status

The View > Status Bar command hides or displays the bar with the statissmation that
displays at the bottom of the 3500Pro window. &ethis command to display or hide the
status bar.
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8.24

8.24.1

8.2.4.2

8.2.4.3

8.2.4.4

Matrix Status

The View > Matrix Status command displays the status of the available dastims. The
information shown in this window automatically upet as changes occur. Three types of

columns display in this window (see Figure 122):

Matrix Status:1

MATRIX STATUS

Dests

VIDEO

AUDIO 1

APRISA A

APRISA B
AUDIO T
AUDlIO 8
AUDIO 9
AUDIO 10
AUDSUB
ELUE
EQC
DUET 1
DUET 2
INF 1
INF 2
OFFICE
ouUT 43
OouUT 45
OouUT 48
ouT 58

BEmA AL

PLAYER 1

TELCO 2
TELCO 2
CAME
CAME
TELCO 2

PLAYER 1
PLAYER 1
PLAYER 1

AARA S

YTL

CAM 6
CAM S
CAM 6
TELCO 2
TELCO 2

TELCO 2

Figure 122: Matrix Status Window

Dests

This displays all of the destinations.

Lock

This indicates if the destination is locked or whied.

If it is locked, a "lock" icoﬂ

displays in the field. Click on theock field next to the destination to Lock or Unlock the

destination (toggle function).

Levels

The remainder of the columns in this section digplth of the levels that are defined for the
configuration. For each destination, the sourspldys on the Destination’s row.

Sources

This displays the available sources.
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8.2.4.5

Take

TheTake button switches a specific physical switch. Yon parform alake on single or
multiple destinations.

1. Select the fields for the routers on which yantto perform a take. When you select
a field, the border of the field highlights. Yoarcselect multiple fields:

2. Select the first field, press the Shift key,niselect the last field. All fields in between
will highlight.

3. Select the first field, then press the Ctrl ké&eep the Ctrl key pressed down while you
select additional fields. Each one you select ligts.

After you select all of the fields, select Baurce.

SelecfTake, and the source you selected displayed in thdiglgkd fields.

You cannot perform atake on a locked destination.

8.2.4.6

8.2.4.7

8.2.4.8

Lock

ThelLock button locks the selected destination.

Unlock

TheUnlock button unlocks the selected destination.

Right-click Menu Options
If you right-click your mouse, three menu optiomspthy (see Figure 123):
Take

Source Skakus
Cefinition

Figure 123: Menu Options

e Take: performs a take. Select tBestinations, then theSources, then right click
and select this button.

e Source Status: Displays matrix status information for the sétecSource.

e Definition: Displays the Level number and Input/Output numfze the selected
destination or source.
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8.25

8.2.5.1

8.2.5.2

8.2.5.3

8.25.4

Preset

TheView > Preset window allows you to build complex combinationsafitches and to take
them simultaneously on the router (see Figure 124).

Matrix Preset: 1

PRESET BUILDER

AUDIO1 | Aupio2 SIS

L= B B W RS R

Lock After
u Take

Delete r Clear Lock
Before Take

Figure 124: Preset Builder Window

Dest

This displays the destinations. Double-click @mitin the Destinations field on the right side
of the window to assign it to this field.

Lock

This indicates if théestination is locked. If it is locked, a "lock" ico,ﬂ gilays in the
field. Click on thd_ock field next to the destination to Lock or Unloclettiestination.

Router

This displays the sources for the router. Doullitk@n item in theSources field on the
right side of the window to assign it to this field

Sources
This displays the available sources.
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8.2.5.5

8.2.5.6

8.2.5.7

8.2.5.8

8.2.5.9

8.2.5.10

8.2.5.11

8.2.5.12

8.2.5.13

8.2.5.14

Destinations

This displays the available destinations.

Clear All

This removes all of the information from the PreBeiider.

Clear Selected

This removes the information from the selected romwghe Preset Builder. To select
multiple rows, select the first field, press thafSkey, then select the last field. All fields in
the selections highlight.

Insert Rows

This adds a new row above the currently selected ro

Delete Rows

This removes the currently selected row.

Get Mtx Current
This loads the current matrix that is configurethwheView > Matrix Status option.

Take All
This performs a Take on all of the destinations.

Take Selected

This performs a Take on only the selected destinati To select multiple destinations,
perform one of the following:

1. Select the first field, press the Shift key, thefest the last field. All of the selected
fields in between will highlight.

2. Select the first field and then, press @td key. Keep th€trl key pressed down while
you select additional fields. Each one that ydacsewill highlight.

Lock After Take

This locks the destinations after performing a TaKeocks are set per destination on the
preset grid.)

Clear Lock Before Take
Clears all locked Destinations before performinigée.
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8.2.5.15 Save
This saves the Preset settings in this window. filéevill have a.preset extension.

8.2.5.16 Load

Loads preset settings into tReeset Builder. You must have used the Save button in this
window to save your settings before you will beedtol load information with this button.

8.2.6 Salvo

The View > Salvo option displays information about the salvos the¢ defined in the
configuration (see Figure 125). A salvo is a grofipredefined logical switches taken at the
same time. All switches in a salvo are taken withie same vertical interval.

Controller Salvos: 1

3500Pro Salvos:

VIDEQ |AUDIO ' |AUDIO: |AUDIO .

Figure 125: Salvo Status Window

8.2.6.1 Salvo

This shows specific information about the salvot tlsaselected in the 3500Pro Salvos
section.

8.2.6.2 3500Pro Salvos

Shows a list of the salvos currently defined in teafiguration file. Select each salvo to
review information about it in the Salvo section.
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8.2.6.3 Fire Salvo
This executes the selected salvo.
8.2.7 Reentry

The View > Reentry option displays direct source-to-destination stetr every configured
reentry (see Figure 126).

Reentry Status: 1

Connection Status for Reentry: m

Reentry as Destination:

VIDEO |AUDIO 1 | AUDIO 2 AUDIO 3 | AUDIO 4
CAMSE CAMS

VIDED |AUDIO - |AUDIO: |AUDIO: |AUDIO .

Figure 126: Reentry Status Window

8.2.7.1  Connection Status for Reentry

This displays the reentries that are currently laée. To define a reentry, use the
Configuration > Reentry command in th€onfiguration Editor module.

8.2.7.2 Reentry as Destinations

This shows the destination status of the selecedtry.

8.2.7.3 Reentry as Source

This shows the source status of the selected seentr
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8.2.8 Source Status

The View > Source Status command shows the destinations (by level) thatcareently
switched to the specified source (see Figure 127).

Source Status: 1

Matrix Status for Source:

Figure 127: Source Status Window

8.2.9 Tidline

The View > Tielines window shows all of the defined tielines and alBoyou to "free up"
existing tielines. Tielines are special typesagfital switches that allow a logical input on one
level to be switched to a logical output on a défe level. The following example (see Figure
128 on the next page) demonstrates a tieline hesed to route a video signal from an analog
camera, through an external analog-to-digital cteveto a digital VTR.

The tielines menu item is available whenTeline Status screen is being displayed. It
contains the following menu selections:

e Sort Ascending
e Sort Descending
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Tieline Status1
Defined Tielines:

Tieline Level From Level To

Tieline Status for ‘

Tieline Free Up Tielines

Local Sources:

B Override Locks

Figure 128: Tieline Status Window

8.2.9.1 Before Using This Command

You must define tielines before they will displaythis window. To define tielines, use the
Configuration > Tielines command in the Configuration Editor module.

8.2.9.2 Options

Defined Tielines shows all of the currently defined tielines.

Tieline Status For. displays the status of a specific tieline. Stetetieline from the
drop-down list.

Free Up Tielines remove tieline definitions you created in then@guration Editor
(Configuration > Tieline command). Select the seurontaining the tieline, and select
Free Tieline.

Local Sources displays the sources that have assigned tielines
Override Locks: overrides locked sources.

Free Tieline frees tieline associations.
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8.2.10 Maitrix Confidence

The View > Matrix Confidence command displays information about the matrixustasee
Figure 129). You cannot edit any of the informatin this window. If the matrix confidence
charts display in green, there is high confiderag the controller can communicate with the
matrix. If the chart displays in red, there is nohfidence in the matrix.

Confidence Status:1
Components:

AUDIO 1

Confidence Matrix:
Inputs 1 - 144

Qutputs
1- 144

Component Info: Current Block:

Matrix Type: PRC
Strobe: 3

Starting Input: 1
Ending Input: 144
Starting Output: 1
Ending Qutput: 144

Figure 129: Matrix Confidence Window

8.2.10.1 Before Using This Command

e You must have set up the configuration for each pament with the 3500Pro
Configuration Editor module with th€onfiguration > System Configuration >
Level/Comp command (in the Configuration module).

e The configuration files you are working with ardiga

8.2.10.2 Components:

At the top of the window, the available componedisplay. You can click on each
component to view the matrix status.

¢ Component Info

When you click on each component in the top portrthe window, information
about the component displays in this area. Therimdtion includes Matrix Type,
Strobe, Starting Input, Ending Input, Starting Quif@nd Ending Output.
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e Confidence Matrix

This window is a map of the physical inputs and g8l outputs of the selected
component. Each small square represents one physigtch. If the confidence is
good, the block displays in green. Physical svescin blocks having a confidence
error will be display in red. Move your cursor ovbe different blocks to review
information about it in the Current Block section.

e Current Block

This displays the Inputs and Outputs for the blibek you have the mouse cursor over
in theConfidence Matrix graphic.

8.2.11 Pand Status

The View > Panel Status command displays information about the availatdegis (see
Figure 130). You cannot edit any of this inforroati To change configuration information for
the panels, use th€onfiguration Editor module. Refer toPanels in the 3500 Pro
Configuration Editor.

Panel Status:1 M [=1E3

Port Address Name Type Description

12 1 AD MP32
2 |2 2 PROD MP32
3 |2 3 DIR MP32
4 2 4 TD1 MP32
5 |2 5 TD2 MP32
6 |2 8 TD3 MP32
7|2 7 TD 4 MP32
8 |2 8 TD XY XY
9 |2 9 MBL MP32
10 10 MBC MP32
11 2 11 GFX1 MP32
12 2 12 BBL MP32
13 2 13 GFX2 MP32
14 2 14 VTR 1 MP32
15 2 15 VIR 8 MP32
16 2 16 VTR 2 MP32
17 2 17 VTIRT MP32
18 2 18 VIR 3 MP32
19 18 VTR 8 MP32
20 |2 20 VTR 4 MP32
21 2 21 VTR 9 MP32
22 |2 22 VTR S MP32
23 23 VTR 10 MP32
24 2 24 vTQc MLDT
25 |2 25 VTR 17 MP32
26 2 26 VTR 18 MP32
27 |2 27 VTR 18 MP32
28 2 28 VTR 20 MP32
28 2 29 EIC XY XY
30 (2 30 EIC 72 MLDT
"l_ll 2 a1 VINNP 1 npa2 f

Figure 130: Panel Status Window
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The following information displays for each panel:

1. Port Displays the port number of the panel.
Address Displays the address for the panel.
Name Displays the name of the panel.
Type Displays the type of panel.

a M wDn

Description: Displays the description information enterednie@onfiguration
Editor.

“~ TIP: Double-click the column title to sort the column in ascending or descending order.

Select theReset button to reset the panel.

The panel will be offline until the reset procedures complete!

8.2.12 Readback Status

The View > Readback Status command displays the physical switches that arecitly
active as reported by the routing switcher (seereid31).

You cannot edit any of the information in this windbw.

Readback Status:1

Components:

AUDIO 1

=]
o
23

Component Info:

1
2
3
4
3
6
7
8

Matrix Type: PRC
Strobe: 3

Starting Input: 1
Ending Input: 144
Starting Qutput: 1
Ending Output: 144

Commands:

Figure 131: Readback Status Window
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8.2.12.1

8.2.12.2

8.2.12.3

8.2.12.4

8.2.13

Components

This displays the currently active components. clClon each component to review
information about it in other parts of the window.

Dest

Displays the physical outputs defined for the comg selected in the Components section.
The first column displays the Destination names #redsecond column displays physical
outputs.

Component Info

Displays the following information about the compahthat is selected in the Components
section: Matrix Type, Strobe, Starting Input, Ending Input, Starting Output, andEnding
Output.

Physical Switch

This opens a second window that allows you to perfsimple takes and all call/diagonal
diagnostic procedures.

Memory Status

TheView > Memory Status command displays memory information about therotliet (see
Figure 132). Thé&Reset Controller button resets the controller. You cannot edit any of the
information in this window.

Controller Info:

Controller Software: 3500Pro,Betaba

Memory Status:

Heap Free: 2357347

Biggest Heap Block: 2325578
Novram Free: 159700
Biggest Novram Block:
2097152

Figure 132: Memory Status Window
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The following information displays:

1. Controller Software: Displays the name and current version of thetrotar
software.

2. Memory Status: Displays general information about the memoats, including
Help Free, Biggest Heap Free, Novram Free, andBiggest Novram Block.

3. Reset Controller: Causes the controller to reset.

This will take the controller off line during the reset period and will reset all

user panels. Only select this option if you are _se that this is what you
want!
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8.3 TooLs MENU

The Tools menu provides options to refresh the currentlynopendow, enable and disable the
switcher, and view the current controller states (SBigure 133).

Tools

Conkroller Skatus. ..
v Offline \Warning

Reinitialize Status

Disable Elock Check.
v Enable Block Check.

Disable Switcher
v Enable Switcher

Disable Background Update
v Enable Background Update

Figure 133: Tools Menu

831  Controller Status
TheTools > Controller Status command displays status information about therodet.

8.3.2  OfflineWarning

TheTools > Offline Warning command, if selected, displays a message whecuotfteoller is
offline. Select this command to turn this optionand off.

8.3.3 Reinitialize Status

TheTools > Reinitialize Status command updates the display in the selected winddhis
ensures that the information that displays in ugate.

8.34 Disable Block Check

TheTools > Disable Block Check command turns block checking off. This can bduise
when troubleshooting system problems. This willssthe current state to be reported and, if
desired, allows it to be toggled.

8.3.5 Enable Block Check

TheTools > Enable Block Check command turns block checking on. If you usedTtbels
> Disable Block Checking command to turn block checking off, use this comdnnturn
block checking back on.
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8.3.6

8.3.7

8.3.8

8.3.9

8.3.10

Disable Switcher

TheTools > Disable Switcher command disables the switcher. To enable thekantagain,
selectTools > Enable Switcher.

Enable Switcher
TheTools > Enable Switcher enables a switcher.

Disable Background Update

TheTools > Background Update Disable! turns off standard background activity that occurs
during the readback status screen.

Enable Background Update

TheTools > Enable Background Update turns on standard background activity the 3500Pro
performs in displaying the read-back window. Anés, this background activity could cause
the computer to run slower, so you can turn off blaekground checking to increase CPU
performance. If you use thBools > Disable Background Update command to turn off
background activity, use the same command to emiable

Controller Status
TheTools > Controller Status command displays status information about therodet.
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8.4

84.1

8.4.2

8.4.3

8.4.4

STATUS MENU

The Status Menu options (see Figure 134) define how items in thatrd Status window
display. This menu will not be available until ysalectView > Matrix Status and theMatrix
Status window is active.

Skatus

. Refresh
Sort Ascending
Sort Descending

Preview Destination. ..

Figure 134: Status Menu

Refresh

The Status > Refresh option updates the information in tihatrix Status window. This
option ensures that the information that displaypgo date.

Sort Ascending

The Status > Sort Ascending option displays information in thilatrix Status window in
numeric ascending order (smaller numbers displalyestop of the window).

Sort Descending

The Status > Sort Descending option displays information in thidatrix Status window in
numeric descending order (larger numbers displalyestop of the window).

Preview Destination

The Status > Preview Destination command allows you to preview what is occurringha
status window.

Click on a cell in the status window and the previgestination is switched to the same status
as the destination corresponding to the active cell
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8.5 PRESET MENU

The Preset menu (see Figure 135) provides options for workaiidy the Preset window. This
menu will not be available until you seladiew>Preset and thePreset window is active. The
following options are available:

851 Load

Preset

Load...
Save As...

Delete Rows
Insert Rows
Clear Selected
Clear all

Capture Currenk Matkrix Skatus

Take Selected
Take all

Figure 135: Preset Menu

The Preset > Load command opens BRreset Configuration (.preset file). You can save
preset configurations with ti&ave button on thé’reset window or theSave As command in
this menu.

8.5.1.1 Before Using This Command

You must have used tl8ave button in thePreset window or theSave As command in this
menu to save preset settings.

8.5.1.2 Loading a Preset File

1.
2.
3.

Select this option, and tidpen window displays
Change to the directory that contains the prfiésetou want to load.

Select the file you want to load. You can dSeldes with either.preset or .txt
extensions.

SelecOpen and the file will load into th@reset window.
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8.5.2 Save As

The Preset > Save As command saves the information in freset window to a file name
and directory location that you select. The filel be saved as greset file.

8.5.2.1 Before Using This Command

Use thePreset window to build your preset settings.

8.5.2.2  Saving the Preset Builder Settings

1. Set up th€reset window.
Select th@reset > Save As command. Th&ave As window displays.
Select the directory location to store the file.

Type in a file name. The file will automatigaiave apreset extension.

o > DN

SelectSave and the file will be saved to your computer that gan open the file later.

85.3 Delete Rows

The Preset > Delete Rows command deletes the selected row in the Presatowin This
option is the same as selecting Brelete Rows button in thePreset window.

85.4 | nsert Rows

The Preset > Insert Rows command adds a new row above the selected roneiRreset
window. This option is the same as selectingrisert Rows button in thePreset window.

855 Cleared Selected

The Preset > Clear Selected option removes the information from the selecteds in the
Preset window. To select multiple rows, select the filistd, press the Shift key, then select
the last field. All fields in between will highlig. This option is the same as selecting the
Clear Selected button in thePreset window.

856  Clear All

ThePreset > Clear All option removes all of the information from tReeset Builder. This
option is the same as selecting @lear All button in thePreset window.

8.5.7  Capture Current Matrix Status

The Preset > Capture Current Matrix Status option loads the current matrix that is
configured with theView > Matrix Status option into thePreset Builder window. This
option is the same as selecting @&t Mtx Current button in thePreset Builder.
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8.5.8

8.5.9

Take Selected

The Preset > Take Selected option performs a take on only the selected dastins. To
select multiple destinations:

Select the first field, press the Shift key, thetest the last field. All fields in between will
highlight.

Select the first field, then press the Ctrl keyeeld the Ctrl key pressed down while you select
additional fields. Each one you select will higyhli.

This option is the same as selectingTha&e Selected button in thePreset Builder window.

Take All

The Preset > Take All button performs a take on all of the destinatiofi$is option is the
same as selecting thake All button in thePreset Builder window.
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8.6  TIELINE MENU
TheTieline menu provides options for working with the Tielwandow. You cannot access this
menu until you seleciew > Tieline to display the tieline window and the tieline wavd is
active (the border of the window will highlight).
8.6.1  Sort Ascending
TheTieline > Sort Ascending command sorts the tielines in ascending order.

e Before using this command, you must have sele¢ted > Tieline to open theTieline
window, and theTieline window must be active. To make tlieline window active,
selectWindow > Tieline Status.

8.6.2  Sort Descending

TheTieline > Sort Descending command sorts the tielines in descending order.

e Before Using This Command, you must have sele¢ied > Tieline to open th&ieline
window, and theTieline window must be active. To make theline window active,
selectWindow > Tieline Status.

8.7 PANEL MENU

The Panel menu (see Figure 136) sorts information in Wiew > Panel Status window.
Before you can access these commands, you must ¥@&ev > Panel Status and th@anel
Status window must be displayed. The following omands are available:

| Panel

1 Sork Ascending
Sort Descending

Figure 136: Panel Menu

8.7.1  Sort Ascending

The Panel > Sort Ascending command sorts information in tlianel Status window in
ascending order.

8.7.2  Sort Descending

The Panel > Sort Descending command sorts information in thanel Status window in
descending order.
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8.8 READBACK MENU

TheReadback menu (see Figure 137) sorts information in\iew > Readback Status
window. Before you can access these commandsnysti selecView > Readback Status and
theReadback Status window must be displayed. The following omands are available:

Readback,

Sort Ascending
Sort Descending

Pheesical Switch. ..

Figure 137: Readback Menu

88.1  Sort Ascending

The Readback > Sort Ascending command sorts information in tHeeadback Status
window in ascending order.

8.8.2  Sort Descending

The Readback > Sort Descending command sorts information in tiReadback Status
window in descending order.

883  Physical Switch

TheReadback > Physical Switch command allows you to perform simple takes, dll ead
diagonal diagnostic procedures (see Figure 138).

Physical Switch:1

Simple Take

Component to

Input: m # Switch:
Output: m M

All Call / Diagonal ——

Starting Input: m #

Starting Output:

Ending Output: n |

W Wrap

Figure 138: Physical Switch
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8.8.3.1

8.8.3.2

8.8.3.3

Components to Switch

Before working with the window, first select thengoonent you want to switch. The
available components display in this drop-down list

Simple Take

The Simple Take section switches a specific physical switch. Bofgrm a Simple Take
sequence, complete the following:

1. Select thénput andOutput to switch.
2. Select th@ake button.

All Call

An all call is a diagnostic procedure that causesingle physical input to be switched to a
range of physical outputs, for a specified compgneith a single command.

Example (see Figure 139): Assume the existenceoofponent RED spanning physical
inputs 1 through 6 and physical outputs 1 throughA8 call can be used to switch physical
input 3, to physical outputs 2 through 6, with rg& command.

PHYSICAL
INPUTS

L— COMPONENT RED

L1

— 2

®

® — 3

@ — 4 PHYSICAL
® 5 OUTPUTS
® — 6

— 7

— 8

Figure 139: All Call Example
Complete the following to perfordll Call function:
1. Select the Starting Input
2. Select the Starting Output.
3. Select the Ending Output.
4. Select the All call button.
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8.8.3.4

8.8.3.5

8.8.3.6

Diagonal

A diagonal is a diagnostic procedure that causesi@e of physical inputs to be switched to a
range of physical outputs, in a diagonal patteantisiy from a specified coordinate and
continuing until either the inputs or outputs axéausted, for a specified component, with a
single command.

Example (see Figure 140): Assume the existenceoofponent RED spanning physical
inputs 1 through 6 and physical outputs 1 through @iagonal with a starting input of 2 and
a starting output of 1 would cause the followinggbal switches to be taken: (2,1), (3,2),
(4,3), (5,4), and (6,5).

PHYSICAL
INPUTS
123456738
L1 | |l COMPONENTRED

® /— 1
® — 2
® — 3

® — 4 PHYSICAL

® 5 OUTPUTS
— 6
— 7
— 8

Figure 140: Diagonal Diagnostic Example
Complete the following to perform a Diagonal sequeen
1. Select thé&tarting Input
Select th&tarting Output.
Select th&nding Output.
Select th&Vrap option to ensure that all of the inputs and outpuésprocessed.

a 0D

Select th®iagonal button.

Restore Router

Select the Restore Router button to return thanmgwitcher to the original state before you
performed takes, all calls, or diagonal diagngstacedures.

Exit
This function closes thiehysical Switch window.
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Chapter 9 - 3500Pro User Manager

The 3500Pro Connection/User Manager (see Figure 141) module allows you to configure
your computer connections and to add and edit wgleoscan access the 3500Pro software.

3500Pro Connection/User Manager o ] [
File Help

Path Options

Awailble Users:

Figure 141: User Manager Window
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9.1 CONNECTION TAB

The Connection tab defines connection parameters used to corthectPC to the actual
controller (see Figure 142).

3500Pro Connection,/User Manager !E E

Eile Help

Serial Port Connection

COM Part: TeTeT - Baud Rates LR -
ol Connection

Contraller Address:  [ERRIERIE S TCP Port: m

FF

Present Connection: hrough CON4 at 38400 Baud.

Figure 142: Connection Tab

9.11  Serial Port Connection
Select this check box if you will connect to theatroller through a serial port.

9.1.2 COM Port

Select the COM Port you are using to connect toctivdroller if you are using a serial port
connection.

9.1.3 Baud Rate
Select the baud rate for the connection if youusieg a serial port connection.

9.14  Network Connection
Select this check box if you will connect to thentroller through the network.
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9.1.5 Controller Address
Enter the TCP/IP address of the controller.

9.1.6 Commit

This applies your connection settings. The sedtipou selected will display at the bottom of
the window.

9.1.7 Present Connection

Displays the current method you are connectingp¢ocbntroller, such as "RS-232/422 through
COM1 at 38400 baud".

9.1.8 Reinitialize Communications
Reinitialize serial communications based on whatosed in registry.

9.19 Controller Test

This command performs a test to verify communicatio the controller, similar to the
Controller Status test in an earlier section of thhanual. A window will be displayed
indicating whether communication was establishéfithere is a communication error, you
must recheck the physical connections to the ctetro

Refer to the Hardware chapter in this manual féaitel information about hardware setup.
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9.2 USERSTAB
TheUsers tab allows you to add, edit, and delete usersKgpee 143).

User accounts are optional. If used, at least oneser account must be
assigned all privileges. If no user accounts are ofigured, all users have all

privileges.

=10l =]

3500Pro Connection/User Manager

File Help
Bath Options

F DI

Figure 143: Users Tab

9.21 AddingaUser
1. Select thédd>> button.

2. Enter a name for the user.
3. Select theset Password button, and enter a password for the user.

Make sure each user knows his or her initial usermae and password.

4. Select the privileges the user should havet skisct each check box, and a check mark
will display. If the user needs access to evenghselect th&et All button. At least

one user must be assigned all privileges.

5. When you are done, sel&eommit. The user will be added to ti#evailable Users
section in the left portion of the screen, anduser will now have access to the software.
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9.2.2 Editing a User
1. Select the user you want to edit from Awailable Users list.
2. Select th&dit>> button.

3. Change any of the settings. To change the mpmdswelect th&et Password button
and enter the new password.

4. Select th€ommit button, and you changes will be saved.

9.23 Deleting a User
1. Select the user you want to delete fromAkailable Users list.
2. Select th®elete button. The user is removed from fheailable Users list.
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9.3 PATH OPTIONS TAB

ThePath Options tab (see Figure 144) displays information aboatdinectory location of items
in the 3500Pro configuration. You cannot edit ahthis information.

3500Pro Connection/User Manager - | Dlﬂ
File Help

ath Options

;. CAProgram Fil

rograrm Fil

- TECHPLES

Figure 144: Path Options Tab
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Chapter 10 - Runtime Database Initialization

The Runtime Database Initialization module makes new copies of the configuration and
runtime databases (from the master copies). Tdldnjersions of the databases are purged. Use
this option when you first install the softwaren dddition, you can use this option if you are
having problems with modules correctly reading entrcontroller information. For example, if
you download a configuration to the controller, bl Status module is not recognizing the
current setting, use this command. This commaridensure that the databases the software is
reading contain the most current information.
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